MOTU 24i™
User’s Guide for Macintosh
SAFETY PRECAUTIONS AND ELECTRICAL REQUIREMENTS

WARNING: TO REDUCE THE RISK OF FIRE OR ELECTRICAL SHOCK, DO NOT EXPOSE THIS APPLIANCE TO RAIN OR OTHER MOISTURE.

CAUTION: TO REDUCE THE RISK OF ELECTRICAL SHOCK, DO NOT REMOVE COVER. NO USER-SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

WARNING: DO NOT PERMIT FINGERS TO TOUCH THE TERMINALS OF PLUGS WHEN INSTALLING OR REMOVING THE PLUG TO OR FROM THE OUTLET.

WARNING: IF NOT PROPERLY GROUNDED THE 24i audio interface COULD CAUSE AN ELECTRICAL SHOCK.

The 24i audio interface is equipped with a three-conductor cord and grounding type plug which has a grounding prong, approved by Underwriters' Laboratories and the Canadian Standards Association. This plug requires a mating three-conductor grounded type outlet as shown in Figure A below.

If the outlet you are planning to use for the 24i audio interface is of the two prong type, DO NOT REMOVE OR ALTER THE GROUNDING PRONG IN ANY MANNER. Use an adapter as shown below and always connect the grounding lug to a known ground. It is recommended that you have a qualified electrician replace the TWO prong outlet with a properly grounded THREE prong outlet. An adapter as illustrated below in Figure B is available for connecting plugs to two-prong receptacles.

Figure A

![Figure A](image)

Properly grounded 3-prong outlet

Grounding lug

3-prong plug

Grounding prong

Figure B

![Figure B](image)

Grounding lug

Screw

Make sure this is connected to a known ground.

3-prong plug

2-prong receptacle

Adaptar

WARNING: THE GREEN GROUNDING LUG EXTENDING FROM THE ADAPTER MUST BE CONNECTED TO A PERMANENT GROUND SUCH AS TO A PROPERLY GROUNDED OUTLET BOX. NOT ALL OUTLET BOXES ARE PROPERLY GROUNDED.

If you are not sure that your outlet box is properly grounded, have it checked by a qualified electrician. NOTE: The adapter illustrated is for use only if you already have a properly grounded two-prong receptacle. Adapter is not allowed in Canada by the Canadian Electrical Code. Use only three wire extension cords which have three-prong grounding type plugs and three-prong receptacles which will accept the 24i audio interface plug.

IMPORTANT SAFEGUARDS

1. Read instructions - All the safety and operating instructions should be read before operating the 24i audio interface.
2. Retain instructions - The safety instructions and owner's manual should be retained for future reference.
3. Heed Warnings - All warnings on the 24i audio interface and in the owner's manual should be adhered to.
4. Follow Instructions - All operating and use instructions should be followed.
5. Cleaning - Unplug the 24i audio interface from the computer before cleaning and use a damp cloth. Do not use liquid or aerosol cleaners.
6. Overloading - Do not overload wall outlets and extension cords as this can result in a risk of fire or electrical shock.
7. Power Sources - This 24i audio interface should be operated only from the type of power source indicated on the marking label. If you are not sure of the type of power supply to your location, consult your local power company.
8. Power-Cord Protection - Power-supply cords should be routed so that they are not likely to be walked on or pinched by items placed upon or against them. Pay particular attention to cords and plugs, convenience receptacles, and point where they exit from the 24i audio interface.
9. Lightning - For added protection for the 24i audio interface during a lightning storm, unplug it from the wall outlet. This will prevent damage to the 24i audio interface due to lightning and power line surges.
10. Servicing - Do not attempt to service this 24i audio interface yourself as opening or removing covers will expose you to dangerous voltage and other hazards. Refer all servicing to qualified service personnel.
11. Damage Requiring Service - Unplug the 24i audio interface from the computer and refer servicing to qualified service personnel under the following conditions.
   a. When the power supply cord or plug is damaged.
   b. If liquid has been spilled or objects have fallen into the 24i audio interface.
   c. If the 24i audio interface has been exposed to rain or water.
   d. If the 24i audio interface does not operate normally by following the operating instructions in the owner's manual.
   e. If the 24i audio interface has been dropped or the cabinet has been damaged.
   f. When the 24i audio interface exhibits a distinct change in performance, this indicates a need for service.
12. Replacement Parts - When replacement parts are required, be sure the service technician has used replacement parts specified by the manufacturer or have the same characteristics as the original part. Unauthorized substitutions may result in fire, electric shock or other hazards.
13. Safety Check - Upon completion of any service or repairs to this 24i audio interface, ask the service technician to perform safety checks to determine that the product is in safe operating conditions.

ENVIRONMENT

Operating Temperature: 10°C to 40°C (50°F to 104°F)

AVOID THE HAZARDS OF ELECTRICAL SHOCK AND FIRE

Do not handle the power cord with wet hands. Do not pull on the power cord when disconnecting it from an AC wall outlet. Grasp it by the plug.

INPUT

Line Voltage: 100 - 120 volts AC, RMS (US and Japan) or 220 - 250 volts AC, RMS (Europe). Frequency: 47 - 63 Hz single phase. Power: 7 watts maximum.

CAUTION: DANGER OF EXPLOSION IF BATTERY IS REPLACED. REPLACE ONLY WITH THE SAME OR EQUIVALENT TYPE RECOMMENDED BY MANUFACTURER. DISPOSE OF USED BATTERY ACCORDING TO MANUFACTURER'S INSTRUCTIONS.
Contents

5 Quick Reference: 24i I/O Front Panel
6 Quick Reference: 24i I/O Rear Panel
7 Quick Reference: PCI-324 Audio Card
9 Quick Reference: 24i Expansion I/O
11 Quick Reference: MOTU 324 Console Window
13 About the 24i
17 Core System Packing List and Macintosh System Requirements
19 Installing the 24i Hardware
27 Installing the 24i Macintosh Software
31 MOTU 324 Console Window
39 Using the 24i with Digital Performer
43 Using the 24i with AudioDesk
47 Using the 24i with Cubase VST
51 Sound Manager
57 Expanding Your 24i System
61 Reducing Latency
67 Troubleshooting
Mark of the Unicorn License Agreement and Limited Warranty on Software

TO PERSONS WHO PURCHASE OR USE THIS PRODUCT: carefully read all the terms and conditions of this agreement before using this software package. Using this software package indicates your acceptance of the terms and conditions of this license agreement.

Mark of the Unicorn, Inc. ("MOTU") owns both this program and its documentation. Both the program and the documentation are protected under applicable copyright laws. Your right to use the program and the documentation are limited to the terms and conditions described herein.

License

YOU MAY: (a) use the enclosed program on a single computer; (b) physically transfer the program from one computer to another provided that the program is used on only one computer at a time and that you remove any copies of the program from the computer from which the program is being transferred; (c) make copies of the program solely for backup purposes. You must reproduce and include the copyright notice on a label on any backup copy.

YOU MAY NOT: (a) distribute copies of the program or the documentation to others; (b) rent, lease or grant sublicenses or other rights to the program; (c) provide use of the program in a computer service business, network, time-sharing, multiple CPU or multiple user arrangement without the prior written consent of MOTU; (d) translate or otherwise alter the program or related documentation without the prior written consent of MOTU.

Term

Your license to use the program and documentation will automatically terminate if you fail to comply with the terms of this Agreement. If this license is terminated you agree to destroy all copies of the program and documentation.

Limited Warranty

MOTU warrants to the original licensee that the disk(s) on which the program is recorded will be free from defects in materials and workmanship under normal use for a period of ninety (90) days from the date of purchase as evidenced by a copy of your receipt. If failure of the disk has resulted from accident, abuse or misapplication of the product, then MOTU shall have no responsibility to replace the disk(s) under this Limited Warranty.

THIS LIMITED WARRANTY AND RIGHT OF REPLACEMENT IS IN LIEU OF, AND YOU HEREBY WAIVE, ANY AND ALL OTHER WARRANTIES, BOTH EXPRESS AND IMPLIED, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE LIABILITY OF MOTU PURSUANT TO THIS LIMITED WARRANTY SHALL BE LIMITED TO THE REPLACEMENT OF THE DEFECTIVE DISK(S), AND IN NO EVENT SHALL MOTU BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING BUT NOT LIMITED TO LOSS OF USE, LOSS OF PROFITS, LOSS OF DATA OR DATA BEING RENDERED INACCURATE, OR LOSSES SUSTAINED BY THIRD PARTIES EVEN IF MOTU HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS WHICH MAY VARY FROM STATE TO STATE. SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Update Policy

In order to be eligible to obtain updates of the program, you must complete and return the attached Mark of the Unicorn Updater Registration Card to MOTU.

General

This License Agreement shall be governed by the laws of the Commonwealth of Massachusetts and shall inure to the benefit of MOTU, its successors, administrators, heirs and assigns.

Copyright Notice

Copyright © 1999 by Mark of the Unicorn, Inc. All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any human or computer language, in any form or by any means whatsoever, without express written permission of Mark of the Unicorn, Inc., 1280 Massachusetts Avenue, Cambridge, MA, 02138, U.S.A.

Limited Warranty on Hardware

Mark of the Unicorn, Inc. and S&S Research ("MOTU/S&S") warrant this equipment against defects in materials and workmanship for a period of NINETY (90) DAYS from the date of original retail purchase. This warranty applies only to hardware products; MOTU software is licensed and warranted pursuant to separate written statements.

If you discover a defect, first write or call Mark of the Unicorn at (617) 576-2760 to obtain a Return Merchandise Authorization Number. No service will be performed on any product returned without prior authorization. MOTU will, at its option, repair or replace the product at no charge to you, provided you return it during the warranty period, with transportation charges prepaid, to Mark of the Unicorn, Inc., 1280 Massachusetts Avenue, MA 02138. You must use the product's original packing material for shipment, and insure the shipment for the value of the product. Please include your name, address, telephone number, a description of the product, and the original, dated bill of sale with the returned unit and print the Return Merchandise Authorization Number on the outside of the box below the shipping address.

This warranty does not apply if the equipment has been damaged by accident, abuse, misuse, or misapplication; has been modified without the written permission of MOTU; or if the product serial number has been removed or defaced.

ALL IMPLIED WARRANTIES, INCLUDING IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF THE ORIGINAL RETAIL PURCHASE OF THIS PRODUCT.

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED. No MOTU/S&S dealer, agent, or employee is authorized to make any modification, extension, or addition to this warranty.

MOTU/S&S ARE NOT RESPONSIBLE FOR SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY BREACH OF WARRANTY, OR UNDER ANY LEGAL THEORY, INCLUDING LOST PROFITS, DOWNTIME, DAMAGE OR REPLACEMENT OF EQUIPMENT AND PROPERTY AND COST OF RECOVERING REPROGRAMMING, OR REPRODUCING ANY PROGRAM OR DATA STORED IN OR USED WITH MOTU/S&S PRODUCTS.

Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or consequential damages, so the above limitation or exclusion may not apply to you. This warranty gives you specific legal rights, and you may have other rights which vary from state to state.

MOTU Audio, AudioDesk, Digital Performer and Mark of the Unicorn are trademarks of Mark of the Unicorn, Inc.

This equipment has been type tested and found to comply with the limits for a class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio or television equipment reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by any of the following measures:

- Relocate or reorient the receiving antenna
- Increase the separation between the equipment and the receiver
- Plug the equipment into an outlet on a different circuit than that to which the receiver is connected
- Consult the dealer or an experienced radio/television technician for additional assistance.

PLEASE NOTE: only equipment certified to comply with Class B (computer input/output devices, terminals, printers, etc.) should be attached to this equipment, and must have shielded interface cables in order to comply with the Class B FCC limits on RF emissions.

WARNING: changes or modifications to this unit not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.
Quick Reference: 24i I/O Front Panel

This is a standard quarter-inch stereo headphone jack. Its output matches the 24i's main outputs, but the volume knob to the right controls the headphone output only.

Indicates the current sample rate. If both of these lights flash simultaneously, it means that you have chosen (via software) an external clock source (such as word clock, external MIDI clock, or external S/PDIF clock). In this case, check your external clock source or its 24i clock setting in the 24i Console window, or check your external clock source and its cable connections to the 24i.

This knob controls the volume of the headphone output only.

Output metering for the Main Outs.

This is the master output level for the 24i's main outputs, but also the gain for the headphone output. Turn it up or down as needed to set the right volume for the headphone output only.

This level controls the volume of the headphone output only.

Output metering for the 24 analog inputs.

Indicates the current sample rate. If both of these lights flash simultaneously, it means that you have chosen (via software) an external clock source (such as word clock, external MIDI clock, or external S/PDIF clock). In this case, check your external clock source or its 24i clock setting in the 24i Console window, or check your external clock source and its cable connections to the 24i.
Quick Reference: 24i I/O Rear Panel

Connect the 24i to the PCI-324 card here using the Audio Wire cable provided with your 24i system.

These two balanced, +4dB TRS jacks serve as the 24i's main outputs. To hear material from them, assign any tracks you want to hear to the 24i main outs 1-2.

The 24i's twenty four analog inputs are gold-plated, balanced, +4dB TRS connectors. They have 24-bit, 128x oversampling A/D converters.

Use the word clock input and output to resolve the 24i to other devices or synchronization sources.

These are stereo S/PDIF outputs that mirror the 24i's main analog outputs (to the right). The left-hand connector supplies optical "TOSLink" S/PDIF output, and the right-hand connector supplies RCA "coax" S/PDIF output.
Quick Reference: PCI-324 Audio Card

Connect the PCI-324 card to the 24i I/O here using the Audio Wire cable included with your 24i system. If you use your own 1394 cable, it should not be longer than 15 feet.

Connect additional 24i I/Os here — or mix and match the 24i with other MOTU interfaces like the 2408, 1224 or 308. You can connect up to three I/Os to a PCI-324 card for a total of 72 active inputs and 54 outputs (with one 24i and two 2408s).

If you have a MOTU Digital Timepiece, connect one of its 'Control Track' outputs here using a standard RS422 DIN-8 cable. This allows you to synchronize your 24i system to the Digital Timepiece for resolving the 24i to external time code (or other external clocks).

If you are using the 24i with one or more ADATs, use this standard ADAT SYNC INPUT to connect the PCI-324 card to the end of your ADAT sync chain. Doing so allows you to resolve the 24i system with the ADATs so that audio transferred between them stays in sync. However, if you regularly need to do transfers between your computer and ADATs, get a 2408 I/O, which allows you to transfer the audio digitally.
Quick Reference: 24i Expansion I/O

EXPANSION I/O OR CORE SYSTEM?
Read this chapter if you have purchased the 24i audio interface as an an Expansion I/O for a core 24i, 2408 or 1224 system. If you've purchased a core system, skip to the next chapter.

PACKING LIST FOR THE EXPANSION I/O
The MOTU Audio 24i Expansion I/O ships with:
- One 24i I/O rack unit
- One 15-foot “AudioWire” cable
- One CD-ROM with drivers and Setup Wizard
- Power cord
- One 24i Windows/Mac manual and reg card

INSTALLING THE 24I EXPANSION I/O
To connect your 24i Expansion I/O to a 24i, 2408 or 1224 core system, use one of the two available Audio Wire sockets on your core system's PCI-324 card as shown below in Figure 1.

Connecting the 24i Expansion I/O to the 24i Interface:
Connect the other end of the Audio Wire cable to the Audio Wire socket on the 24i interface as shown below in Figure 2.

Figure 1: You can connect up to three 24i I/Os to a PCI-324 card.

Figure 2: Attaching the Audio Wire cable to the 24i Expansion I/O.

IMPORTANT NOTE
Always power on your 24i Expansion I/O when operating your core system. In fact, you should turn on all audio interfaces connected to the PCI-324 card.

UPDATING SOFTWARE
Your Expansion I/O includes a CD-ROM with updated software that is necessary to run your Expansion I/O with your core system. Be sure to run the installer on the Expansion I/O disc to ensure that the software in your system will support your Expansion I/O.

COMPLETING THE INSTALLATION
To complete the installation, open 324 Console to confirm that the PCI-324 card and its updated software drivers see the newly installed Expansion I/O and to configure your multi-interface system. For details, turn to chapter 12, “Expanding Your 24i System” (page 57).

SYNCHRONIZATION AND CLOCK SOURCE
For details about synchronizing a multiple-I/O system, see “Synchronizing multiple 24i’s” on page 58.
Quick Reference: MOTU 324 Console Window

If you have two or three 24i's connected to the PCI-324 card in your computer, use this menu to choose which one you are controlling with the settings in the middle portion of this window.

The Clock Source menu determines the master clock source for your entire 24i system. This is an important setting when you are resolving the 24i to external clock sources.

This section of the window shows the I/O formats provided by the 24i (or other MOTU interface). The stand-alone Console window, above, is the same as this "Configure Hardware Driver" dialog found in AudioDesk and Digital Performer (in their Basics menu, as shown above).

If you have two or three 24is (or 2408s) connected to the PCI-324 card in your computer, use this menu to choose which one you are controlling with the settings in the middle portion of this window.

This section of the window has general settings that are related to the PCI-324 card, not the 24i I/O(s) connected to it.

The 'Enable Input' check boxes refer to input to the computer. If checked, the inputs will be available in the input menus of AudioDesk, Digital Performer, or other host audio applications that support the 24i.

The 'Output Source' menus determine what you'll hear from the 24i's outputs. When it says 'From Computer', then the output pair will appear in the output menus in AudioDesk, Digital Performer, or other host audio applications that support the 24i. And any tracks assigned to that pair of outputs will be heard from them.

The 'Monitor Outputs' menu determines where you'll hear audio produced by auditioning, scrubbing, or previewing Premiere plug-ins in AudioDesk or Digital Performer. This also determines which outputs the 124 Sound Manager driver will use.

How to open this window
The MOTU 324 Console Window gives you complete control over the settings in your 24i hard disk recording system. There are several ways to access the 324 Console window. But the window is the same, regardless of how you access it.

How to open this window

- From the Mac OS desktop, run MOTU 324 console (the stand-alone applet for the 24i)
- From within AudioDesk or Digital Performer, go to the Basics menu and choose MOTU Audio System options > Configure Hardware Driver

Check 'Enable Routing' to expand the window as shown. This view lets you enable individual inputs and outputs and route inputs to outputs directly within the system (without a host audio program).

Choosing a smaller setting here reduces the latency you may hear when recording live inputs. But lower settings also increase the strain on your computer. For details, see "Samples per buffer" on page 34.

This menu identifies the analog inputs and main outputs provided by the 24i. It cannot be changed when viewing 24i I/O settings in this window. (Several menus appear here when viewing 2408, 1224 or 308 I/O settings in this window.)

The 'Enable Input' check boxes refer to input to the computer. If checked, the inputs will be available in the input menus of AudioDesk, Digital Performer, or other host audio applications that support the 24i.

The 'Clock Source' menu determines the master clock source for your entire 24i system. This is an important setting when you are resolving the 24i to external clock sources.

The 'Monitor Outputs' menu determines where you'll hear audio produced by auditioning, scrubbing, or previewing Premiere plug-ins in AudioDesk or Digital Performer. This also determines which outputs the 124 Sound Manager driver will use.

This section of the window has general settings that are related to the PCI-324 card, not the 24i I/O(s) connected to it.

This section of the window shows the I/O formats provided by the 24i (or other MOTU interface).

How to open this window

- From the Mac OS desktop, run MOTU 324 console (the stand-alone applet for the 24i)
- From within AudioDesk or Digital Performer, go to the Basics menu and choose MOTU Audio System options > Configure Hardware Driver

The stand-alone Console window, above, is the same as this "Configure Hardware Driver" dialog found in AudioDesk and Digital Performer (in their Basics menu, as shown above).

This option is only available from within Digital Performer and AudioDesk. For details, see chapter 13, "Reducing Latency" (page 61).
CHAPTER 3  About the 24i

OVERVIEW
The 24i is a computer-based, 24-bit hard disk recording system for Mac OS and Windows 95/98 that offers 24 simultaneous inputs and a pair of main outputs. The system consists of a PCI card connected to a standard 19-inch, single-space, rack-mountable I/O unit. The external I/O unit offers the following:

- 24 gold-plated, balanced +4dB TRS analog inputs with 24-bit A/D converters
- 2 gold-plated, balanced +4dB TRS analog outputs with 24-bit D/A converters
- One RCA “coax” S/PDIF stereo output (24-bit)
- One optical “TOSLink” S/PDIF stereo output (24-bit)
- A quarter-inch, stereo headphone output with volume knob (on the front panel)

The 24i supplies exceptionally high-quality audio on its 24 analog inputs and main outputs, which provide a dynamic range of 111 dB.

Up to three 24i I/O units can be connected to the system's single PCI card for a maximum of 72 inputs and 18 output connections. Or you can connect up to two additional 2408 I/Os for up to 48 channels of digital I/O in ADAT optical and/or Tascam T/DIF formats.

The system includes AudioDesk™, full-featured audio workstation software for Mac OS that supports both 16-bit and 24-bit recording.

For Windows, a Wave driver is included for compatibility with audio applications that support standard multi-channel Windows Wave drivers.

Also included are ASIO drivers on both Macintosh and Windows for multi-channel operation with Steinberg Cubase VST for Macintosh and Windows, and other audio programs that support ASIO drivers.

The 24i system can record and play back at either 44.1 or 48kHz sampling rates.

THE 24i I/O REAR PANEL
24 inputs and stereo outputs
The 24i I/O is a single-space, rack mountable chassis with gold-plated analog audio connectors on its rear panel and level meters on the front. The rear panel has 24 gold-plated, balanced +4dB TRS analog inputs with 24-bit A/D converters. Stereo main outs are supplied in three different formats:

- 2 gold-plated, balanced +4dB TRS analog outputs with 24-bit D/A converters
- One RCA “coax” S/PDIF stereo output (24-bit)
- One optical “TOSLink” S/PDIF stereo output (24-bit)

All inputs and outputs can be accessed simultaneously.

24-bit audio
The analog inputs and outputs are equipped with 24-bit, 128x oversampling A/D and D/A converters. Internally, the 24i has a 24-bit data path to and from the computer so that all audio data is carried to/from the computer in 24 bits.
Converters
All analog-to-digital and digital-to-analog converters on the 24i are extremely high-quality, latest-generation converters. The converters on the 24i’s 24 inputs, as well as the main outputs, provide a signal-to-noise ratio of 111 dB.

Word clock in and out
BNC Word clock connectors (in and out) are provided for synchronization with standard word clock devices.

THE 24i I/O FRONT PANEL
Level Meters
The front panel of the 24i I/O displays 24 level meters for the 24 analog inputs, arranged in three banks of 8 channels. For each channel, there is a six-segment meter that measures from -40 dB to 0 dB.

The left half of the front panel provides similar stereo metering for the main outs (in all three formats).

Two LEDs on the far right of the front panel indicate the current sample rate (44.1 or 48 kHz).

Headphone output
The 24i front panel includes a quarter-inch stereo headphone output jack and volume knob. The headphone output matches the main stereo outs, while the volume knob controls the volume of the headphone output only.

THE PCI-324 CARD
The 24i system ships with a single PCI audio card called the PCI-324. The card features a custom processor, three 1394-type 'Audio Wire' connectors, an ADAT SYNC IN connector, and a Digital Timepiece 'Control Track' sync connector (DIN-8 socket).

Expansion
The Audio Wire connectors allow up to three 24i I/O units to be connected at one time, providing you with 72 inputs and 18 output connections. The 24i system uses standard 1394 components, but it employs a proprietary communication protocol between the card and the external I/O to handle the extremely low latencies required by the system. The heart of the PCI-324 card is a custom-programmed VLSI chip capable of simultaneously processing 72 inputs and outputs (144 channels total) at either 44.1 or 48 KHz. The custom chip handles all of the system’s I/O processing, freeing up the host computer’s processing bandwidth for real-time DSP effects and hard disk I/O. The custom processor also allows the system to act as a massive, 72 by 72 patch bay, allowing you to route any input to any output (or combination of outputs).

Expansion with the MOTU 2408 interface
Mark of the Unicorn’s popular 2408 digital interface can be connected to the PCI-324 card in a core 24i system, providing 24 additional channels of input and output in many formats: ADAT optical, Tascam TDIF, S/PDIF and RCA analog. Up to two 2408s can be connected to a core 24i system for a total of 72 inputs and 66 outputs.

Sample-accurate synchronization
The PCI-324 card’s standard 9-pin ADAT SYNC IN connector allows the 24i to be continuously resolved with ADAT tape decks — or any other digital audio synchronizer that supports ADAT SYNC. If a MOTU 2408 I/O is connected to the PCI-324 card, this connection provides sample-accurate synchronization with all Alesis ADAT tape decks connected to the 24i/2408 system. For example, if you digitally transfer a single track of material from the ADAT via the 2408’s light pipe connection into AudioDesk or Digital Performer (which both support sample-accurate sync), and then transfer the track back to the ADAT, it will be recorded exactly at its original location.
Digital Timepiece Control Track sync

The PCI-324 card’s RS-422 Control Track connector allows the 24i to be continuously resolved with MOTU’s Digital Timepiece universal A/V synchronizer. If a MOTU 2408 I/O is connected to the PCI-324 card, this connection provides the sample-accurate synchronization with the Digital Timepiece. For example, if you have a Tascam DA-38/88/98, you can use a Digital Timepiece to synchronize your 24i/2408 system with Tascam tape decks to perform sample-accurate transfers in the same manner as just described for ADATs. Control Track is a proprietary, sample-accurate digital audio synchronization protocol developed by Mark of the Unicorn.

16-BIT AND 24-BIT RECORDING

The 24i’s on-board A/D and D/A converters are 24-bit converters, and the 24i system handles the data internally with a 24-bit signal path. Using AudioDesk™, the 24i’s Macintosh workstation software (included), you can record 16-bit or 24-bit audio files at either 44.1 or 48 KHz. On Windows, 24-bit audio files can be recorded with any compatible host application that supports 24-bit recording.

AUDIODESK

AudioDesk is a full-featured audio workstation software package for Mac OS included with the 24i system. AudioDesk provides multi-channel waveform editing, automated virtual mixing, graphic editing of ramp automation, real-time effects plug-ins with 32-bit floating point processing, crossfades, support for many third-party audio plug-ins (in the MOTU Audio System andAdobe Premiere formats), background processing of file-based operations, sample-accurate editing and placement of audio, sample-accurate synchronization with ADATs and Tascam tape decks and more.

DIGITAL PERFORMER

The 24i system is fully integrated with MOTU’s award-winning Digital Performer audio sequencer software package.

OTHER AUDIO SOFTWARE

The 24i system ships with a standard multi-channel Windows Wave (.WAV) driver that allows you to record, edit, play back and mix your 24i projects using your favorite Wave-compatible Windows software.

The 24i system also ships with a standard Mac OS Sound Manager driver for stereo I/O with any audio application that supports Sound Manager.

The 24i also includes an ASIO driver for multi-channel compatibility with Steinberg Cubase VST and other programs that support ASIO drivers.

A COMPUTER-BASED SYSTEM

Regardless of what software you use with the 24i, the host computer determines the number of tracks the software can record and play simultaneously, as well as the amount of real-time effects processing you can apply to your mix. A faster computer with more RAM and faster hard drives will allow more simultaneous tracks and real-time effects than a slower computer with less RAM and slower hard drives. A 200+ MHz Power Macintosh or Pentium II PC should allow your software to play 16-24 simultaneous tracks of audio (although your results may vary depending on your software and hardware). Today’s fastest computers can typically play as many as 32 tracks or more. Standard third-party SCSI acceleration products can also help you achieve higher track counts.
CHAPTER 4  Core System Packing List and Macintosh System Requirements

PACKING LIST FOR THE 24i CORE SYSTEM
If you have purchased a 24i Expander, see “Packing list for the Expansion I/O” on page 9.

The MOTU Audio 24i core system ships with the items listed below. If any of these items are not present in your 24i box when you first open it, please immediately contact your dealer or Mark of the Unicorn.

- One 24i I/O rack unit
- One PCI-324 PCI audio card
- One 15-foot “AudioWire” cable
- Power cord
- One 24i Mac/Windows manual
- One AudioDesk Manual
- One cross-platform CD-ROM
- Product registration card

MACINTOSH SYSTEM REQUIREMENTS
The 24i system requires the following Macintosh system:

- A 200 MHz 604e-based Power Macintosh or faster
- A G3-based Power Mac or faster is recommended
- At least 32 Mb (megabytes) of RAM (64 Mb is recommended)
- One available PCI slot
- Mac OS version 7.6.1 or later
- A large hard drive (preferably at least 4 Gb)

PLEASE REGISTER TODAY!
Please send in the registration card included with your 24i system. As a registered user, you will be eligible to receive on-line technical support email and announcements about product enhancements as soon as they become available. Only registered users receive these special update notices, so please, complete and mail this registration card!

There is also an AudioDesk software registration card found at the beginning of your AudioDesk manual. Please be sure to fill out and return this card as well, so that you will be eligible to receive on-line technical support email and announcements about AudioDesk software enhancements as soon as they become available.

Thank you for taking the time to register your new Mark of the Unicorn products!
CHAPTER 5 Installing the 24i Hardware

OVERVIEW
Here’s the basic procedure for installing the 24i:

Install the PCI-324 audio card ................. 20
Insert the PCI-324 card into any available PCI slot inside your Power Macintosh computer.

Connect the 24i interface ................. 21
Connect the 24i audio interface to the PCI-324 card via the Audio Wire cable (use the Audio Wire port closest to the DIN-8 Control Track socket on the PCI-324).

Connect inputs and main outputs ........ 22
Make all desired line-level +4 dB analog connections. Connect the analog and/or S/PDIF main outputs.

Connect word clock ......................... 23
Connect the 24i’s word clock input or output as necessary to resolve the 24i to an external source.

Using Control Track or ADAT Sync ........ 25
Either of these sync connections to the 24i’s PCI-324 card can be used instead of word clock to resolve the 24i to a MOTU Digital Timepiece A/V synchronizer or any ADAT synchronizer.

TRY THE 24i SETUP WIZARD
The 24i software CD-ROM includes an easy-to-use Setup Wizard. This interactive software tutorial will help you figure out the best way to connect all your gear to the 24i. This chapter covers important general concepts regarding connections and synchronization, but the 24i Setup Wizard asks you specific questions about your gear and then makes specific recommendations for you based on your answers. To use the Wizard, just run the 24i software installer on the 24i CD-ROM, and then look for it on your hard drive when the installation is done.
INSTALL THE PCI-324 AUDIO CARD

1 Switch off and unplug your computer.
   - Failure to do so may result in serious shock or injury.
2 Open your computer.
3 Find an available PCI slot.
4 Remove the slot cover, if necessary.
5 Before removing the PCI-324 card from its anti-static bag, touch the power supply inside your computer to discharge any static electricity that may have built up on you.
6 Remove the PCI-324 card from its anti-static bag.
7 Gently but firmly insert the card into any available PCI slot.
8 Secure the bulkhead of the PCI-324 card to the computer chassis with the bolt from the slot cover.
   - We strongly recommend securing the PCI-324 card in this manner. Doing so allows you to ensure secure connections to the card later on in the installation.
9 Place the cover back on your computer.
10 Reconnect the power cord to the computer before proceeding.

Figure 5-1: Installing the PCI-324 card.
CONNECT THE 24i INTERFACE

1 Plug one end of the 24i system Audio Wire™ cable (included) into the Audio Wire socket next to the DIN-8 Control Track socket on the PCI-324 card as shown below in Figure 5-2.

2 Plug the other end of the firewire cable into the 24i I/O as shown below in Figure 5-2.

Important note: if you are connecting multiple interfaces to a single PCI-324 card, be sure to turn them all on when you're using the system, even if you don't plan to use a particular interface. This ensures trouble-free operation.
CONNECT INPUTS AND MAIN OUTPUTS
Make connections to the 24i inputs and main outputs as desired. Here are a few things to keep in mind when doing so.

Connect them all, if you like
All of the 24i's inputs and outputs can be active simultaneously.

Avoid adaptors
If you don’t have the right cable, you’ll avoid headaches later on — and ensure the best possible audio quality — by taking the time to obtain the correct cable.

+4 dB analog inputs/outputs
The 24i’s analog connectors are calibrated at +4 dB, so if you are plugging in a microphone, you’ll need a mic preamp of some kind (or a connection to a mixer with a mic pre).

24-bit audio
All of the connectors on the 24i support 24-bit audio, so you can connect 24-bit devices to it.

S/PDIF connections
For best performance with RCA S/PDIF connections, be sure to use standard 75 Ohm coax cables (not audio cables with RCA connectors). The TOSLink optical S/PDIF output takes any standard TOSLink optical cable. Be sure the S/PDIF device you connect to the 24i is set up to synchronize to its S/PDIF input.

Mixing live inputs with the 24i
With all of the mixing and processing that is possible in AudioDesk, Digital performer and today’s crop of other powerful audio software, it is possible to treat the 24i system as a complete, stand-alone recorder and mixer. You can plug in synthesizers, microphones (with a preamp), and any other analog sources, and then mix and process them all within your computer.

If you intend to take this approach, with no external mixing in your setup, you need to be aware of an important issue: patch-thru latency when monitoring live inputs. With a host computer-based system like the 24i, there is an inherent amount of delay in a live input signal being routed through the system and monitored live through the system’s outputs. For example, if you have a rhythm section already recorded, and you play a live guitar on top of it, the live guitar will sound a fraction of a second late compared to the pre-recorded mix. The guitar would get recorded with the correct timing, but the live monitoring would sound late.

Fortunately, the 24i has buffer settings you can adjust to minimize this latency — or make it completely inaudible. But these adjustments come at a cost: the processing power of your computer. Lower latency means more of a load on your computer’s CPU. On a fast computer, this is less of an issue. You can record and mix a fairly large, multi-track project, even with your 24i system adjusted for low latency. But on slower computers, you may not have the computing power to do everything you want to do while patching through a live input. Our advice is: if you plan to patch live inputs into your 24i system, get the fastest computer you can.

For more information, see chapter 13, “Reducing Latency” (page 61).

Figure 5-3: The 24i gives you 24 inputs and stereo main outputs in three formats: 24-bit analog, optical S/PDIF and RCA S/PDIF.
CONNECT WORD CLOCK

The 24i supports both a word clock IN and OUT.

Do you need word clock?

If you will be using only the 24i's analog inputs and outputs, and you have no plans to synchronize your 24i system to SMPTE time code, you don't need word clock. You can skip the rest of this chapter and proceed to chapter 6, “Installing the 24i Macintosh Software” (page 27). After doing so, you'll open the 324 Console Window and set the Clock Source setting to 24i: Internal as shown below in Figure 5-4. For details, see chapter 7, “MOTU 324 Console Window” (page 31).

Figure 5-5: Slaving another digital audio device to the 24i. For the 24i's clock source, choose any source besides '24i: Word clock'.

Situations that require word clock sync

If either of the following situations are true, you'll need to use the 24i's word clock sync features:

- You need to synchronize the 24i with other digital audio devices so that their digital audio clocks are phase-locked with each other.

- You need to synchronize the 24i system to SMPTE time code, such as from a video deck or an analog multi-track tape recorder.

Choose a digital audio clock master

In either of the above cases, you need to choose an audio clock master. In the simplest case, you have two devices and one is the word clock master and the other is the slave as shown below in Figure 5-5 and Figure 5-6.

Don't chain word clock

If you have three or more digital audio devices that you need to synchronize, avoid chaining their word clock connections (OUT to IN, OUT to IN, etc.), as this causes problems. Instead, use a dedicated synchronizer like the Digital Timepiece or a word clock distribution device of some kind.
**Advanced setups**

If you have several devices, including the 24i, that must be synchronized with each other, slave them all to a single clock master, such as a MOTU Digital Timepiece.

**The 24i offers several audio sync formats**

Remember, you have several ways to slave a 24i to a synchronizer like the Digital Timepiece. You can use word clock (connected to the 24i itself), ADAT SYNC (connected to the PCI-324 card) or Digital Timepiece Control Track (connected to the PCI-324 card). These latter two connections free up the Digital Timepiece's word clock output for another device that only supports word clock.

---

**Figure 5-7:** To synchronize several devices with the 24i, use a dedicated synchronizer like a MOTU Digital Timepiece. Notice that you can use Control Track for the 24i to free up the other sync formats (ADAT Sync and Word Clock) for other devices.
The 24i system's PCI-324 card offers two sync connectors: ADAT Sync In and Control Track (for the Digital Timepiece). Either of these sync formats can be used instead of word clock to resolve the 24i to external sources and maintain phase lock with other digital audio devices, as discussed in the previous sections.

**Digital Timepiece Control Track**

To use Control Track, use the (standard) circular DIN-8 cable that ships with the Digital Timepiece to connect one of its Control Track ports to the Control Track jack on the 24i system's PCI-324 card as shown in Figure 5-7.

**ADAT Sync**

To use ADAT Sync, use a standard ADAT sync cable to connect SYNC OUT from another device (an ADAT or ADAT-compatible synchronizer) to the SYNC IN port on the PCI-324 card. If you have a several devices in an ADAT sync chain, place the PCI-324 card at the end of the chain (as it has no ADAT SYNC OUT port).
CHAPTER 6 Installing the 24i Macintosh Software

OVERVIEW
The 24i ships with the following software components:

<table>
<thead>
<tr>
<th>Software component</th>
<th>Location</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOTU Folder</td>
<td>Extensions Folder</td>
<td>Contains the drivers and hard disk recording engine for the PCI-324 card and hardware. Required for 24i operation.</td>
</tr>
<tr>
<td>MOTU 324 Console</td>
<td>Top level of your startup disk</td>
<td>Provides access to all of the settings in the PCI-324 and 24i hardware. Required for 24i operation.</td>
</tr>
<tr>
<td>AudioDesk Workstation Software</td>
<td>Top level of your startup disk</td>
<td>Provides complete multi-track recording, mixing and processing. Optional.</td>
</tr>
<tr>
<td>ASIO MOTU PCI-324 Driver</td>
<td>In the ASIO Drivers folder of Cubase VST or any other ASIO dependent audio program</td>
<td>Allows Cubase VST or other ASIO-compliant software to do multi-channel input and output with the 24i. Only required if you are using Cubase VST or another ASIO-dependent program.</td>
</tr>
<tr>
<td>MOTU 324 Sound Manager Driver</td>
<td>Extensions Folder</td>
<td>Allows any Sound Manager compatible software to do stereo input and output with the 24i hardware. Optional.</td>
</tr>
<tr>
<td>Demo Project</td>
<td>Anywhere you want</td>
<td>Provides a multi-track mix that you can open, play, and mix in AudioDesk. Optional.</td>
</tr>
<tr>
<td>MOTU Setup Wizard</td>
<td>Top level of your startup disk</td>
<td>Asks you questions about the gear you'll connect to the 24i, and then helps you set everything up, including the software</td>
</tr>
<tr>
<td>PCI-324 Cue Mix Console</td>
<td>Top level of your startup disk</td>
<td>Gives you complete control over the 324 driver’s Cue Mix feature, which provides low-latency patch thru of live inputs through your 24i system.</td>
</tr>
</tbody>
</table>

Running the 24i software installer ........... 28
Setup Wizard ..................................... 28
MOTU Folder ..................................... 28
MOTU 324 Console ................................. 28
AudioDesk workstation software ............... 29
ASIO MOTU 324 Driver ......................... 29
MOTU 324 Sound Manager Driver ............... 30
PCI-324 Cue Mix Console ....................... 30
RUNNING THE 24i SOFTWARE INSTALLER
Insert the Macintosh and Windows compatible 24i installer CD-ROM into your Macintosh and run the 24i installer on the CD. It will guide you through the installation. If you are unsure about what components to install, refer to the rest of the sections in this chapter, which explain the purpose of each software item.

SETUP WIZARD
Check out the Setup Wizard. It helps you configure the PCI-324 driver for you based on your setup.

MOTU FOLDER
The MOTU Folder goes in the Extensions Folder inside the System Folder on the Macintosh startup disk.

The MOTU Folder contains the “under the hood” software drivers and hard disk recording engine for the 24i hardware. It also holds the real-time effects processing plug-ins used by MOTU Audio system compatible software, such as AudioDesk and Digital Performer.

The items in the MOTU Folder are required by all 24i-compatible software.

MOTU 324 CONSOLE
The MOTU 324 Console application is placed by the 24i software installer on the top level of your Mac’s startup disk. It gives you access to all of the basic settings in your PCI-324 and 24i hardware, such as synchronization settings, routing to and from the computer, and patchbay routing within the 24i I/O itself (if any).

For complete details, see chapter 7, “MOTU 324 Console Window” (page 31).
AUDIODESK WORKSTATION SOFTWARE
The 24i installer places AudioDesk on the top level of your Macintosh's startup volume.

AudioDesk is an advanced workstation software package for the 24i system that lets you record, edit, mix, process, bounce and master multi-track digital audio recording projects. Advanced features include real-time 32-bit effects processing, sample-accurate synchronization with ADATs and Tascam tape decks, 24-bit recording, and much more.

See the AudioDesk manual included with your 24i system for details.

ASIO MOTU 324 DRIVER
ASIO stands for Audio Streaming Input and Output. The ASIO MOTU 324 driver allows the PCI-324 audio card to do multi-channel input and output with Steinberg's Cubase VST software, or any other audio application that supports ASIO drivers.

The ASIO MOTU 324 driver is only required if you are using Cubase VST (or another audio program that depends on the ASIO driver to do multi-channel I/O with the 24i system).

Digital Performer and AudioDesk do not use the ASIO MOTU 324 driver.

The ASIO MOTU 324 driver should be placed in the ASIO folder of Cubase VST or other ASIO-compliant software that you are running as the software “front end” for your 24i recording system.

For details about using Cubase VST with the 24i, see chapter 10, “Using the 24i with Cubase VST” (page 47).
MOTU 324 SOUND MANAGER DRIVER
The MOTU 324 Sound Manager driver is placed by the 24i software installer in the Extensions Folder of the System Folder on your Mac’s startup disk. This system extension allows the Apple Sound Manager to use the 24i hardware for stereo input and output. In turn, any Sound Manager compatible software can also use the 24i hardware for stereo input and output.

Sound Manager only supports stereo input and output. Therefore, Sound Manager applications can only record and play through two 24i inputs and outputs at a time.

For details about Sound Manager, see chapter 11, “Sound Manager” (page 51).

PCI-324 CUE MIX CONSOLE
This program, when launched, provides a mixing console that gives you control over the PCI-324 driver’s low latency Cue Mix features. For details, see “Even lower latency with Cue Mix” on page 62.
CHAPTER 7  MOTU 324 Console Window

OVERVIEW
The MOTU 324 Console Window gives you complete control over the settings in your 24i hard disk recording system.

Accessing the 324 console window ........... 29
Quick Reference ........................................ 30
PCI-324 Settings .......................... 31
Sample rate ...................................... 31
Clock Source ..................................... 31
'Samples per buffer' ............................ 32
Monitor Outputs ............................ 33
24i Interface settings .................... 33
Working with multiple 24i I/Os ............ 33
Bank menu .................................... 33
Enable Inputs .................................. 34
Output Source ............................... 34
Total PCI use ................................. 34
Mono routing ................................ 35
Interface options ............................. 35
Saving and recalling routings .......... 35
The Refresh button ......................... 35

ACCESSING THE 324 CONSOLE WINDOW
There are several ways to access the 324 Console window:

- From the Mac OS desktop, run MOTU 324 Console (the stand-alone applet for the 24i)
- From within AudioDesk™ or Digital Performer™, go to the Basics menu and choose MOTU Audio System options>Configure Hardware Driver

It doesn't matter which way you access the window. The settings are the same either way.
QUICK REFERENCE

If you have two or three 24i's (or other interfaces) connected to the PCI-324 card in your computer, use this menu to choose which one you are controlling with the settings in the middle portion of this window.

The 'Clock Source' menu determines the master clock source for your entire 24i system. This is an important setting when you are resolving the 24i's to external clock sources.

The 'Monitor Outputs' menu determines where you'll hear audio produced by auditioning, scrubbing, or previewing Premiere plug-ins in AudioDesk or Digital Performer. This also determines which outputs the 324 Sound Manager driver will use.

This section of the window has general settings that are related to the PCI-324 card, not the 24i's connected to it.

The stand-alone Console window, above, is the same as this "Configure Hardware Driver" dialog found in AudioDesk and Digital Performer (in their Basics menu, as shown above).

Choosing a smaller setting here reduces the latency you may hear when recording live inputs. But lower settings also increase the strain on your computer. For details, see "Samples per buffer" on page 32.

Choosing a smaller setting here reduces the latency you may hear when recording live inputs. But lower settings also increase the strain on your computer. For details, see "Samples per buffer" on page 32.

The 'Mono Routing' button displays each input and output individually, rather than in stereo pairs as shown here. For details, see "Mono routing" on page 35.

Figure 7-1: The MOTU 324 Console window gives you access to all of the settings in your 24i hardware.

Figure 7-1: The MOTU 324 Console window gives you access to all of the settings in your 24i hardware.
PCI-324 SETTINGS

The top of the MOTU 324 Console window, as shown in Figure 7-2, has several settings for the PCI-324 card itself. These are settings that are not dependent on the I/Os connected to the card. Instead, they impact the function of the system as a whole.

**Sample rate**

Choose the desired sample rate for recording and playback. The 24i system can operate at either 44.1 KHz (the standard rate for compact disc audio) or 48 KHz. The entire 24i system will run at this sample rate. If you have a S/PDIF device connected digitally to the 24i, make sure its sample rate matches the 24i's sample rate. If you have a Digital Timepiece, MIDI Timepiece AV or other digital audio synchronizer, make sure it matches as well.

Also check your host audio software sample rate setting, if it has one that is independent of the 24i's driver setting.

Mismatched sample rates cause distortion and cracking. If you hear this sort of thing, check the sample rate settings in your hardware and here in the 324 Console window.

**Clock Source**

The clock source determines the digital audio clock that the 24i system will use as its time base.

### PCI-324 Internal

Use the PCI-324: Internal setting when you want the 24i system to operate under its own digital audio clock. For example, you may be in a situation where all you are doing is playing tracks off hard disk in your digital audio software on the computer. In a situation like this, you most often don't need to reference an external clock of any kind. For example, you might simply be playing the hard disk tracks and mixing them to the main outputs of the 24i. In this case, no other digital audio clocks are involved.

Another example is transferring a mix to DAT. You can operate the 24i system on its internal clock, and then slave the DAT deck to the 24i, either via the S/PDIF connection (usually DAT decks slave to their S/PDIF input when you choose it as the input source) or via the 24i's word clock output (if your DAT deck has a word clock input).

For all practical purposes, the PCI-324: Internal setting produces the same results as the 24i: Internal setting explained on page 32.

### PCI-324: Control Track

Control Track is the Digital Timepiece's proprietary digital audio synchronization format. It allows the entire 24i system to slave to a MOTU Digital Timepiece's audio clock.

Use this setting (or the ADAT setting discussed below) when you have a Digital Timepiece as the synchronization hub for your 24i studio.

### PCI-324: ADAT

ADAT refers to the Alesis ADAT digital audio synchronization format. It allows the entire 24i system to slave to the ADAT sync chain connected to your PCI-324 audio card (via the 9-pin connector on the card).
Use this setting when you are using the 24i system with one or more ADATs. Make sure the PCI-324 card is connected to the end of the ADAT sync chain.

You could also use this setting if you have a MIDI Timepiece AV, which also supports ADAT SYNC.

If you have a Digital Timepiece, you can also use ADAT sync instead of Control Track. There is no difference in features or performance.

24i: Word Clock
This setting refers to the Word Clock In BNC connector on the 24i I/O itself. This setting allows the entire 24i system (including other 24i I/Os connect to the PCI-324 card) to slave to an external word clock source, such as the word clock output from a digital mixer or a DA-88 with an SY-88 sync card.

24i: Internal
This setting produces the highest possible audio performance (best signal to noise ratio, etc.) from the 24i system. Use the 24i: Internal setting when you want the 24i system to operate under its own digital audio clock. For example, you may be in a situation where all you are doing is playing tracks off hard disk in your digital audio software on the computer. In a situation like this, you most often don’t need to reference an external clock of any kind. For example, you might simply be playing the hard disk tracks and mixing them to the main outputs of the 24i. In this case, no other digital audio clocks are involved.

For all practical purposes, the 24i: Internal setting produces the same results as the PCI-324: Internal setting explained on page 31.

‘Samples per buffer’
The ‘Samples Per Buffer’ setting lets you reduce the delay you hear when patching live audio through the 24i system and your audio software. For example, you might have MIDI instruments, samplers, microphones, guitars (or other live instruments), a digital mixer or other live audio source connected directly to 24i analog or digital inputs. And if so, you will probably want to monitor those live inputs at the same time as you are listening to tracks already recorded in your audio software. However, when doing so, you’ll very likely hear a delay between the live inputs and the tracks already recorded.

You can use the ‘Samples Per Buffer’ setting to reduce this delay — and even make it completely inaudible.

The ‘Samples Per Buffer’ setting determines the size of the buffers used by the PCI-324 Driver to transfer audio to and from the 24i hardware. This setting has a large impact on the following things:

- The load on your computer’s CPU
- The patch thru latency
- How responsive the transport controls are in AudioDesk, Digital Performer or other audio software

This setting presents you with a trade-off between the processing power of your computer and the delay of live audio as it is being patched through your system. If you reduce the buffer size, you reduce patch thru latency, but significantly increase the overall processing load on your computer, leaving less CPU bandwidth for things like real-time effects processing. On the other hand, if you increase the buffer size, you reduce the load on your computer, freeing up bandwidth for effects, mixing and other real-time operations. But don’t set the buffer size too low, or it may cause distortion in your audio.

If you are at a point in your recording project where you are not currently working with live, patched-thru material (e.g. you’re not recording vocals), or
if you have a way of externally monitoring input, choose a higher 'Samples Per Buffer' setting. Depending on your computer's CPU speed, you might find that settings in the middle work best.

The 'Samples Per Buffer' setting also impacts how quickly your audio software will respond when you begin playback, although not by amounts that are very noticeable. Lowering the buffer size will make your software respond faster; raising the buffer size will make it a little bit slower, but barely enough to notice.

Reducing latency with the 'Samples Per Buffer' setting has another benefit: it lets you route live inputs through the effects processing and mix automation of your audio software.

The Cue Mix console (explained in the next section), can help you choose an optimum buffer size.

Even lower latency — without software effects processing
If your computer is not fast enough to handle lower buffer sizes, or if you would like to reduce the latency even more, you can use the 24i's Cue Mix patch through feature. Cue Mix reduces latency to one quarter of its normal, non-Cue Mix value. In addition, the Cue Mix Console application has a message area that helps you find the optimum buffer setting for your computer. But because Cue Mix patch thru happens at such a low level in the software driver, it does not allow you to monitor the audio material through the real-time software effects in your host audio application. For details, see chapter 11, “Reducing Latency” (page 47).

**Monitor Outputs**
The Monitor Outputs option determines where you will hear things like soundbite auditioning, scrubbing, and Premiere plug-in previewing in AudioDesk and Digital Performer. This setting also determines which outputs the 324 Sound Manager driver will use.

### 24i INTERFACE SETTINGS
The middle portion of the 324 Console Window displays settings for the 24i I/O interface connected to your PCI-324 card.

#### Working with multiple 24i I/Os
If you have two or three 24i I/Os (or MOTU 2408 I/Os) connected to your PCI-324 card, the 324 Console displays settings for one I/O at a time. To view the settings for a particular I/O, choose it from the Configure interface menu as shown below in Figure 7-3.

![Figure 7-3: Choosing a 24i I/O when there are two or three interfaces connected to your PCI-324 card. In this example, the expanded system includes a 1224 audio interface.](image)

#### Bank menu
When you are viewing the settings of a 24i I/O in the window, the bank menu confirms the presence of the 24i analog inputs and cannot be changed. If, however, you view a MOTU 2408 I/O (by choosing it from the “Configure Interface” menu), you would then be able to choose the desired audio format for each of the three 2408 banks. Refer to your 2408 manual for details.

#### THE ENABLE ROUTING CHECK BOX
The Enable Routing check box, when checked, expands the window to display each individual input and output pair. You can then disable individual inputs, if desired, as well as make basic audio routing from inputs to outputs directly with the 24i system (without the use of host audio software).
Check the ‘Enable Routing’ check box (circled above) to expand the window. You can then disable individual inputs, and make basic routing from 24i inputs to outputs without the use of host audio software.

**Enable Inputs**
Check the Enable Inputs check box next to a pair of channels to send their input to the computer. Once the box is checked, the inputs will appear in the input source menus in AudioDesk, Digital Performer or other host audio application.

**Output Source**
The Output Source menus let you choose what you will hear on each pair of outputs.

If you choose None, you'll hear silence.

If you choose From Computer, the output pair will appear in the output menus of AudioDesk, Digital Performer or any other 24i-compatible host audio application. Then, any tracks (or other audio sources) that you assign to the output pair will be heard from the corresponding 24i outputs.

All of the other sources in the menu represent inputs provided by the 24i system itself. If you have two or three 24i I/Os connected to your PCI-324 card, all of their inputs will appear in this menu as well, since the PCI324 card lets you route any input pair to any output pair across the three interfaces. The same is true for the inputs of any other I/Os (2408, 1224, 308, etc.) that are connected to the PCI-324 card.

**Total PCI use**
Enabled inputs and outputs take up a small portion of your computer’s processing power. And while the amount is quite small for individual I/O pairs, an expanded 24i system lets you enable up to 72 inputs and 18 outputs at a time (a total of 90 connections). On large systems like this, you can conserve your computer’s processing power by only enabling inputs and outputs when you are actually using them. Otherwise, leave inputs unchecked, and set outputs to None. On a core 24i system, however, you can leave them enabled without much risk of performance issues arising.

The **Total PCI use** status display tells you the approximate PCI bandwidth being used by the PCI-324 card for the currently enabled inputs and outputs. This display is mostly intended for multiple-24i systems, as the window only shows one 24i I/O at a time. A higher number will alert you that there are a significant number of inputs and outputs enabled, perhaps including the ones you are not currently viewing.

While the theoretical maximum PCI bandwidth is 132 MB per second, there are no hard and fast rules for how much bandwidth is actually available on any given computer. Many factors come in to play, including the efficiency of the bridge chip that controls the PCI bus and the number of other PCI devices on the bus competing for bandwidth. Practically speaking, most of today’s personal computers seem to have approximately 30-50 Mb per second of PCI bandwidth for the PCI-324 and other PCI cards in the computer.

The Cue Mix console (“324 Cue Mix Console” on page 49) provides information about your PCI bus usage for diagnostic purposes. Use it to manage your PCI resources and help with troubleshooting.
MONO ROUTING

When the "Mono Routing" check box is checked, the 324 Console window displays input and output channels independently, instead of in pairs, as shown below in Figure 7-5:

![Figure 7-5: Mono routing.](image)

Patchbay routing within the PCI-324 can be done in mono, whereas computer routing (to and from the computer) can only be done in channel pairs. Therefore, the input check boxes can only be checked and unchecked in pairs. When you click on one input check box, its corresponding check box will respond as well.

Similarly, if you choose "From Computer" from an Output Source menu, the menu for its paired output will also be set to "From Computer."

However, when you choose a 24i input (e.g. Analog 3) from an Output Source menu, only that menu will change to your new setting.

Mono routing does not affect the manner in which the inputs and outputs appear in input/output menus in AudioDesk, Digital Performer or other host audio application.

INTERFACE OPTIONS

The "Interface options" button opens a dialog that tells you the version number of the 24i I/O currently being viewed in the 324 Console window.

SAVING AND RECALLING ROUTINGS

If you have two or three I/Os connected to the PCI-324 card, there are a lot of inputs and outputs to configure in the middle portion of the 324 Console window (one entire “page” for each!). For your convenience, the "Save Config" button lets you save the current routing configuration (including the routing for the 2nd and 3rd I/Os, if you have any) so you can recall the configuration later on with an easy click of the "Load Config" button. Save the file in the standard fashion. Note that only the settings in the middle portion of the window (i.e. the input and output routings) are saved. The PCI-324 settings are not included as part of the configuration, as they are usually system-wide settings that you won't change very often.

THE REFRESH BUTTON

The "Refresh" button makes the 324 Console window query the 24i hardware to make sure that the settings in the window accurately reflect the settings in the hardware. Under normal operations, this should never be necessary. Even if you switch off the 24i hardware, the 324 software driver is specially programmed to re-establish contact with the hardware. Even so, if you suspect that the hardware might be in a different state than what you see in the window, click Refresh.

CHOOSING A CONFIG BEFORE OPENING A FILE

The settings in the 324 Console window are not saved with the files you create and save with host audio applications like AudioDesk, Digital Performer, or third party audio programs. To save time, you can save the current 324 Console Window settings as a file on disk (as explained earlier), along with your host audio program files. If you work on the project later on, you can quickly
load the configuration file, without having to remember how the 324 Console window was configured.

Some host audio applications, like AudioDesk and Digital Performer, remember the 324 Console Window’s input and output settings at the time you last saved a project file. This means that even if the 324 Console Window doesn’t currently have the exact same settings, AudioDesk and Digital Performer display the inputs and outputs that were in effect when the file was last saved. Unavailable inputs/outputs are displayed in italics.

Some third-party host applications, however, lose their input and output settings if they are not available at the time you open the file. You can save yourself the time of reassigning them by saving a 324 configuration along with the file. For details, see “Saving and recalling routings” on page 35.
CHAPTER 8  Using the 24i with Digital Performer

OVERVIEW
Digital Performer Version 2.42 or higher is required for the 24i.

Updating Digital Performer ..................... 39
Setting up your system....................... 39
The MOTU 324 Console window................. 39
Brief overview of 324 settings................. 40
Enabling 24i inputs and outputs .......... 41
Be sure you have enough voices .......... 41
24-bit operation........................... 41
Input monitoring mode...................... 42
Synchronization......................... 42
Reducing delay when monitoring live inputs ... 42
Exchanging files with AudioDesk ............. 42
Monitoring system performance ............. 42

SETTING UP YOUR SYSTEM
In addition to FreeMIDI and the other required System elements supplied by the Digital Performer installer, the 24i software installer updates the drivers in the MOTU Folder (in the Extensions Folder). As described in chapter 6, “Installing the 24i Macintosh Software” (page 27), the Digital Performer and 24i software installers will properly install and update everything for you. For your convenience, here is a brief summary of what Digital Performer requires to run with the 24i:

- The MOTU 324 Driver must be in the MOTU folder (as shown in Figure 6-1 on page 28).
- The MOTU Audio System and MOTU Public Objects items in the MOTU Folder (as shown in Figure 6-1 on page 28) must be the same version as that which gets installed by the 24i installer CD-ROM (or later).
- FreeMIDI must be installed (from either the Digital Performer or 24i installer CD).
- If you are using a MIDI Timepiece AV or Digital Timepiece for synchronization, be sure they are present in your FreeMIDI setup.

THE MOTU 324 CONSOLE WINDOW
The MOTU 324 Console window gives you direct access to all of the settings in your 24i system hardware. To open it, choose MOTU Audio System options>Configure Hardware Driver from the Basics menu. If you don't see the MOTU 324 Console window as shown below in Figure 8-1, choose MOTU PCI-324 from the menu at the top of the Configure Hardware dialog.
The 324 Console window is central to the operation of your 24i hardware with Digital Performer. For complete details about the important settings in this window, see chapter 7, “MOTU 324 Console Window” (page 31).

**BRIEF OVERVIEW OF 324 SETTINGS**

Before you begin using your 24i hardware with Digital Performer, review the settings in the 324 Console window (shown on the previous page in Figure 8-1). The following sections provide a brief explanation of each setting from the perspective of Digital Performer. For a more complete overview of the settings in the MOTU 324 Console window, see chapter 7, “MOTU 324 Console Window” (page 31).

**Sample rate**

Choose either 44.1 or 48 KHz as the overall sample rate for the 24i system and Digital Performer. Newly recorded audio in Digital Performer will have this sample rate. Imported audio or soundbites in existing files that do not match this sample rate will be displayed in the Soundbites window with a red 'X' on its move handle to indicate that it cannot be played.

**Clock Source**

This setting is very important because it determines which audio clock the 24i system will follow.

If you do not have any digital audio connections to your 24i I/O (you are using the analog inputs and outputs only), and you will not be slaving Digital Performer to external SMPTE time code, choose 24i: Internal. This setting produces the highest possible level of audio performance in the 24i.

If you are slaving the 24i hardware system to the ADA T sync Input connector on the PCI-324 card, choose PCI-324: ADA T. If you are slaving the 24i hardware system to the Digital Timepiece Control T rack input on the PCI-324 card, choose PCI-324: Control T rack.

If you do not have any digital audio connections to your 24i I/O (you are using the analog inputs and outputs only), and you will not be slaving Digital Performer to external SMPTE time code, choose 24i: Internal. This setting produces the highest possible level of audio performance in the 24i.

If you are slaving the 24i hardware system to the ADAT sync Input connector on the PCI-324 card, choose PCI-324: ADAT.

If you are slaving the 24i hardware system to the Digital Timepiece Control Track input on the PCI-324 card, choose PCI-324: Control Track.
If you have multiple digital audio devices connected to the 24i, or if you are not sure about the clock source of your setup, be sure to read “Using Control Track or ADAT Sync” on page 25 and “Clock Source” on page 33.

**Buffer Size**

The Buffer Size setting can be used to reduce the delay — or latency — that you hear when live audio is patched through your 24i hardware and Digital Performer. For example, you might have MIDI instruments, samplers, microphones, and so on connected to the analog inputs of the 24i. If so, you will often be mixing their live input with audio material recorded in Digital Performer.

Smaller settings reduce latency, but they also put more demand on your computer's processor (as shown in the Performance Monitor window). For best results, try 256 samples or lower, which reduces latency enough to be inaudible for most audio material. But don’t set it too low, or you might hear distortion in your audio. Keep an eye on the Processor meter in the Performance monitor when making this adjustment. Be sure to try playing some audio, too, as the processor meter can jump up significantly during playback at lower settings. Also, use the PCI-324 Cue Mix console; its message center feature helps you find the optimum Buffer Size setting for your system.

For further information about Cue Mix console and reducing latency, see chapter 13, “Reducing Latency” (page 61).

**Monitor Outputs**

This setting determines where you’ll hear audio produced by soundbite auditioning, audio scrubbing, and real-time previewing of Adobe Premiere audio plug-ins. For details, see “Monitor Outputs” on page 35.

**ENABLING 24i INPUTS AND OUTPUTS**

The middle portion of the 324 Console window lets you control which 24i inputs and outputs you'll see in all of Digital Performer's audio input and output menus. Normally, they are all enabled for Digital Performer. To “hide” a 24i input from Digital Performer (so it doesn't appear in the input menus of audio tracks), uncheck its box. To hide an output, change the output menu to None or any other setting besides. From Computer. For further information about making these settings, see “24i Interface settings” on page 35.

**BE SURE YOU HAVE ENOUGH VOICES**

Once you've enabled the desired 24i audio inputs and outputs, go to the Basics menu and choose MOTU Audio System options>Configure Studio Size. Then check to make sure you have enough mono and stereo audio voices to cover the 24i's twelve outputs. Consult the MOTU Audio System chapter in your Digital Performer manual for further information about the settings in this dialog.

**24-BIT OPERATION**

Your 24i hardware supports Digital Performer's 24-bit recording capabilities. If you would like to record and play back 24-bit audio files, go to the Basics menu, choose MOTU Audio System options>Configure Sample Format, and choose 24-bit recording as the sample format. This setting is saved with the Digital Performer project.
INPUT MONITORING MODE
To determine how Digital Performer will monitor input from the 24i, go to the Basics menu and choose MOTU Audio System options>Input Monitoring Mode. For complete details, see your Digital Performer manual.

SYNCHRONIZATION
Digital Performer can run under its own transport control or slave to an external sync source, such as SMPTE time code or ADAT sync (sample address).

Running DP under its own transport control
If you do not need to synchronize Digital Performer with time code or another recording device, such as a tape deck, just leave the Slave to External Sync command in the Basics menu unchecked.

However, even though Digital Performer is not slaving to external sync, you still need to be concerned with the synchronization of the 24i's digital audio clock with other devices connected to it digitally (if any). For example, if you have a DAT machine connected to the 24i via S/PDIF, you need to make sure that their audio clocks are phase-locked. If you don't have any digital audio devices connected to the 24i, digital audio phase-lock does not apply to you.

Slaving DP and the 24i to SMPTE time code
If you need to slave Digital Performer and the 24i system to SMPTE time code, choose Receive Sync from the Basics menu and choose the MTC (MIDI Time Code) option. Then make sure that the Slave to External Sync command in the Basic menu is checked. To ensure that your audio tracks don't drift out of sync with your MIDI tracks — or time code, use a hardware synchronizer like the MIDI Timepiece AV or Digital Timepiece to slave the 24i hardware to the SMPTE (or MIDI Time) Code as well. A digital audio synchronizer is required for drift-free SMPTE/MIDI time code sync. Make sure the Clock Source setting in the MOTU 324 Console window has the appropriate setting for locking the 24i system to the synchronizer. For examples of how to set this up, see “Connect word clock” on page 23.

REDUCING DELAY WHEN MONITORING LIVE INPUTS
If you have live audio inputs connected to the 24i, such as MIDI synthesizers, samplers, microphones or other live instruments, you might hear a slight delay when their audio is being patched through your 24i hardware and Digital Performer. You can reduce this delay at the expense of increased processing for your computer. For details, see “Buffer Size” on page 41.

EXCHANGING FILES WITH AUDIODESK
Digital Performer files can be opened in AudioDesk. Just open AudioDesk and then use the Open command in the File menu as usual to open the Digital Performer file. We recommend that you immediately use the Save As command to save the file under a different name so that the original Digital Performer file is preserved. If you like, you can even store the two files in the same project folder so that they share the same audio files, analysis files and fades. Digital Performer 2.5 (or higher) can read AudioDesk files. Just open them in the usual way with the Open command in the File menu.

MONITORING SYSTEM PERFORMANCE
The 24i system can push the limits of your computer's processing power, especially if you use a lot of Digital Performer's real time effects plugins. Keep the Audio Performance window open (as shown in Figure 8-2 on page 41) to keep tabs on the load on your CPU and disk buffers. If the meters get too high, reduce the number of effects you are working with.
CHAPTER 9 Using the 24i with AudioDesk

OVERVIEW
This chapter provides a brief overview of AudioDesk's basic I/O and synchronization operation with the 24i hardware. For complete information about all of AudioDesk's powerful workstation features, see the AudioDesk manual included with your 24i system.

Setting up your system .................................. 43
The MOTU 324 Console window .................... 43
Brief overview of 324 settings ......................... 44
Enabling 24i inputs and outputs ..................... 45
Be sure you have enough voices ..................... 45
24-bit operation ........................................... 45
Input monitoring mode .................................... 45
Synchronization .......................................... 45
Reducing delay when monitoring live inputs ...... 46
Exchanging files with Digital Performer .......... 46
Monitoring system performance ...................... 46
AudioDesk and MIDI sequencing ..................... 46

SETTING UP YOUR SYSTEM
As described in chapter 6, “Installing the 24i Macintosh Software” (page 27), the AudioDesk and 24i software installer will properly install and update all of the necessary software components in your Macintosh system. For your convenience, here is a brief summary of what AudioDesk requires to run with the 24i:

- The MOTU 324 Driver must be in the MOTU folder (as shown in Figure 6-1 on page 28).
- The MOTU Audio System and MOTU Public Objects items in the MOTU Folder (as shown in Figure 6-1 on page 28) must be the same version as that which gets installed by the 24i installer CD-ROM (or later).
- If you will be using AudioDesk’s MIDI Machine Control (MMC) or MIDI Time Code sync features, FreeMIDI must be installed. (You can do this from the 24i installer CD.)
- If you are using a MIDI Timepiece AV or Digital Timepiece for synchronization, be sure they are present in your FreeMIDI setup.

THE MOTU 324 CONSOLE WINDOW
The MOTU 324 Console window gives you direct access to all of the settings in your 24i system hardware. To open it, choose MOTU Audio System options>Configure Hardware Driver from the Basics menu.

The 324 Console window is central to the operation of your 24i hardware with AudioDesk. For complete details about the important settings in this window, see chapter 7, “MOTU 324 Console Window” (page 31).
BRIEF OVERVIEW OF 324 SETTINGS

Before you begin using your 24i hardware with AudioDesk, review the settings in the 324 Console window (shown in Figure 9-1). The following sections provide a brief explanation of each setting from the perspective of AudioDesk. For a more complete overview of the settings in the MOTU 324 Console window, see chapter 7, “MOTU 324 Console Window” (page 31).

Sample rate

Choose either 44.1 or 48 KHz as the overall sample rate for the 24i system and AudioDesk. Newly recorded audio in AudioDesk will have this sample rate. Imported audio or soundbites in existing files that do not match this sample rate will be displayed in the Soundbites window with a red ‘X’ on its move handle to indicate that it cannot be played.

Clock Source

This setting is very important because it determines which audio clock the 24i system will follow.

If you do not have any digital audio connections to your 24i I/O (you are using the analog inputs and outputs only), and you will not be slaving AudioDesk to external SMPTE time code, choose 24i: Internal. This setting produces the highest possible level of audio performance in the 24i.

If you are slaving the 24i hardware system to the ADAT sync Input connector on the PCI-324 card, choose PCI-324: ADAT.

If you are slaving the 24i hardware system to the Digital Timepiece Control Track input on the PCI-324 card, choose PCI-324: Control Track.

If you have multiple digital audio devices connected to the 24i, or if you are not sure about the clock source of your setup, be sure to read “Using Control Track or ADAT Sync” on page 25 and “Clock Source” on page 33.

Buffer Size

The Buffer Size setting can be used to reduce the delay — or latency — that you hear when live audio is patched through your 24i hardware and AudioDesk. For example, you might have MIDI instruments, samplers, microphones, and so on connected to the analog inputs of the 24i. If so, you will often be mixing their live input with audio material recorded in AudioDesk.

Smaller settings reduce latency, but they also put more demand on your computer’s processor (as shown in the Performance Monitor window). For best results, try 256 samples or lower, which reduces latency enough to be inaudible for most
audio material. But don't set it too low, or you might hear distortion in your audio. Keep an eye on the Processor meter in the Performance monitor when making this adjustment. Be sure to try playing some audio, too, as the processor meter can jump up significantly during playback at lower settings. Also, use the PCI-324 Cue Mix console; its message center feature helps you find the optimum Buffer Size setting for your system.

For further information about Cue Mix console and reducing latency, see chapter 13, "Reducing Latency" (page 61).

![Figure 9-2: When adjusting the 'Buffer Size' to reduce patch thru latency, watch the 'processor' meter in the Performance Monitor. From the Basics menu, choose 'MOTU Audio System options>Performance Monitor'. If you hear distortion, or if the Performance meter is peaking, open Cue Mix Console and look at its message center for hints as to what’s going on.](image)

**Monitor Outputs**
This setting determines where you’ll hear audio produced by soundbite auditioning, audio scrubbing, and real-time previewing of Adobe Premiere audio plug-ins. For details, see “Monitor Outputs” on page 35.

**ENABLING 24i INPUTS AND OUTPUTS**
The middle portion of the 324 Console window lets you control which 24i inputs and outputs you’ll see in all of AudioDesk’s audio input and output menus. Normally, they are all enabled for AudioDesk. To “hide” a 24i input from AudioDesk (so it doesn't appear in the input menus of audio tracks), uncheck its box. To hide an output, change the output menu to None or any other setting besides. From Computer. For further information about making these settings, see “24i Interface settings” on page 35.

**BE SURE YOU HAVE ENOUGH VOICES**
Once you’ve enabled the desired 24i audio inputs and outputs, go to the Basics menu and choose MOTU Audio System Options>Configure Studio Size. Then check to make sure you have enough mono and stereo audio voices to cover the 24i’s twelve outputs. Consult the MOTU Audio System chapter in your AudioDesk manual for further information about the settings in this dialog.

**24-BIT OPERATION**
Your 24i hardware supports AudioDesk's 24-bit recording capabilities. If you would like to record and play back 24-bit audio files, go to the Basics menu, choose MOTU Audio System options>Configure Sample Format, and choose 24-bit recording as the sample format. This setting is saved with the AudioDesk project.

**INPUT MONITORING MODE**
To determine how AudioDesk will monitor input from the 24i, go to the Basics menu and choose MOTU Audio System options>Input Monitoring Mode. For complete details, see your AudioDesk manual.

**SYNCHRONIZATION**
AudioDesk can run under its own transport control or slave to an external sync source, such as SMPTE time code or ADAT sync (sample address).

Running AudioDesk under its own transport control
If you do not need to synchronize AudioDesk with time code or another recording device, such as a tape deck, just leave the Slave to External Sync command in the Basics menu unchecked.

However, even though AudioDesk is not slaving to external sync, you still need to be concerned with the synchronization of the 24i’s digital audio clock with other devices connected to it digitally (if any). For example, if you have a DAT machine connected to the 24i via S/PDIF, you need to make sure that...
their audio clocks are phase-locked. If you don't have any digital audio devices connected to the 24i, digital audio phase-lock does not apply to you.

**Slaving AudioDesk and the 24i to SMPTE time code**

If you need to slave AudioDesk and the 24i system to SMPTE time code, choose *Receive Sync* from the Basics menu and choose the MTC (MIDI Time Code) option. Then make sure that the *Slave to External Sync* command in the Basic menu is checked. To ensure that your audio tracks don’t drift out of sync with the SMPTE time code, use a hardware synchronizer like the MIDI Timepiece AV or Digital Timepiece to slave the 24i hardware to the SMPTE (or MIDI Time) Code as well. A digital audio synchronizer is required for drift-free SMPTE/MIDI time code sync. Make sure the *Clock Source* setting in the MOTU 324 Console window has the appropriate setting for locking the 24i system to the synchronizer. For examples of how to set this up, see “Connect word clock” on page 23.

**REducing delay when monitoring live inputs**

If you have live audio inputs connected to the 24i, such as MIDI synthesizers, samplers, microphones or other live instruments, you might hear a slight delay when their audio is being patched through your 24i hardware and AudioDesk. You can eliminate this delay at the expense of increased processing for your computer. For details, see “Buffer Size” on page 44.

**Exchanging files with Digital Performer**

Digital Performer files can be opened in AudioDesk. Just open AudioDesk and then use the Open command in the File menu as usual to open the Digital Performer file. We recommend that you immediately use the Save As command to save the file under a different name so that the original Digital Performer file is preserved. If you like, you can even store the two files in the same project folder so that they share the same audio files, analysis files and fades. Digital Performer 2.5 (or higher) can read AudioDesk files. Just open them in the usual way with the Open command in the File menu.

**Monitoring system performance**

The 24i system can push the limits of your computer's processing power, especially if you use a lot of AudioDesk's real-time effects plug-ins. Keep the Audio Performance window open (as shown in Figure 9-2 on page 45) to keep tabs on the load on your CPU and disk buffers. If the meters get too high, reduce the number of effects you are working with.

**AudioDesk and MIDI sequencing**

AudioDesk can play audio as a background application, allowing you to run a sequencer at the same time in the foreground. However, there is no way to continuously synchronize — or resolve — a sequencer with AudioDesk, so the two programs will eventually drift out of sync, even if you manage to start them at the same time. Future versions of AudioDesk or FreeMIDI may support OMS, allowing you to synchronize AudioDesk with any OMS-compatible sequencer. Contact Mark of the Unicorn for late-breaking news on this. But if you prefer AudioDesk and you’d like to do integrated MIDI sequencing with it, your best bet is Digital Performer, which offers all of the same features as AudioDesk, along with powerful, state-of-the-art MIDI sequencing. Talk to your authorized Mark of the Unicorn dealer for details about upgrading from AudioDesk to Digital Performer.
CHAPTER 10  Using the 24i with Cubase VST

OVERVIEW
The 24i includes an ASIO driver that provides multi-channel I/O with Steinberg's Cubase VST family of digital audio sequencers.

Preparation .......................... 47
Run MOTU 324 Console before VST .... 48
Choosing the PCI-324 driver in VST .... 48
Number of channels ................. 48
The Launch button ................... 48
Reducing monitoring latency .......... 49
Audio clock source ................... 49
Other System dialog settings ...... 49
Activating 24i inputs ................. 49
Assigning inputs to channels ...... 49
Assigning outputs to busses ....... 49
Changing 24i settings .............. 50
Synchronization ..................... 50
24-bit operation .................... 50
Monitoring system performance ...... 50

PREPARATION
Before you run VST with your 24i system, you should launch AudioDesk and play back the demo project to make sure that the 24i hardware software drivers are set up properly. The AudioDesk demo project is located on the 24i Installer CD-ROM. Drag it to your hard drive before opening it in AudioDesk, as your CD-ROM drive will be too slow to play the audio.

To make sure that everything is ready for VST, install VST first (if you haven't already done so), and then see these chapters before proceeding:

- chapter 5, "Installing the 24i Hardware" (page 19).
- chapter 6, "Installing the 24i Macintosh Software" (page 27)
- chapter 9, "Using the 24i with AudioDesk" (page 43)
RUN MOTU 324 CONSOLE BEFORE VST
Before you run VST, launch the MOTU 324 Console to configure your 24i hardware. The MOTU 324 Console lets you make several important settings, including the sample rate and audio clock source. For complete details regarding the MOTU 324 Console, see chapter 7, “MOTU 324 Console Window” (page 31).

CHOOSING THE PCI-324 DRIVER IN VST
Once you've made the preparations described so far in this chapter, you're ready to run VST.

To activate the 24i's PCI-324 driver in VST:

1. Choose System from the Audio menu.
2. Choose MOTU PCI-324 from the ASIO device menu.
3. Make the other settings in the dialog as need for your system and synchronization scenario.

NUMBER OF CHANNELS
Be sure to choose enough channels in the System dialog (as shown above in Figure 10-3) to cover the 24i's 24 inputs and main stereo outputs.

THE LAUNCH BUTTON
At this time, the Macintosh version of Cubase does not allow the MOTU 324 Console to run at the same time as VST. Therefore, the Launch button in the System dialog as shown in Figure 10-3 will not launch the MOTU 324 Console. Perhaps this will be addressed in a future update of VST. In the meantime, you can access the MOTU 324 Console in one of two ways:

- Quit VST, and then run the MOTU 324 Console from the Finder, OR
- Temporarily switch to a different ASIO Device in the System dialog, and then run the MOTU 324 Console from the Finder

In either case, any changes you make to the MOTU 324 Console window will be reflected in VST when you reactivate the MOTU PCI-324 ASIO driver in VST.

* Changing input and output settings in the MOTU 324 Console causes VST to lose the input and bussing assignments in any files that don't
match the new settings. To avoid this, you can save a 324 setup on disk with your VST file. Then, the next time you open the VST file, you can load the 324 configuration first so that no settings are lost. For details, see “Saving and recalling routings” on page 37.

**REDUCING MONITORING LATENCY**
The Latency setting in the System dialog cannot be adjusted, but it can be adjusted in the MOTU 324 Console, where it is called *Buffer Size*. For complete information about reducing latency with this setting, see “Samples per buffer” on page 34.

**AUDIO CLOCK SOURCE**
This setting is the same as the Clock Source setting in the MOTU 324 Console window. It determines which audio clock the 24i system will slave to. Choose the setting that is most appropriate for your synchronization scenario. For complete details, see “Clock Source” on page 33.

**OTHER SYSTEM DIALOG SETTINGS**
Consult your VST documentation for details about the rest of the settings in this dialog.

**ACTIVATING 24I INPUTS**
Once you've chosen the MOTU PCI-324 driver in the Audio System dialog, choose *Audio Inputs* from the Audio menu to see the 24i inputs. To activate them, click the *Active* light next to each input.

* If some of the 24i's inputs do not appear in the Audio Inputs window, check in the MOTU 324 Console, as shown in Figure 7-4 on page 36, and make sure that their input check boxes are checked.

**ASSIGNING INPUTS TO CHANNELS**
Once you've activated the 24i inputs as shown in the previous section, you can then assign them to VST audio channels in the Monitor window in the usual fashion: by command-clicking on the input button at the top of each channel strip as shown below in Figure 10-4.

![Figure 10-4: Assigning a 24i input to a VST audio channel: command-click the input button at the top of the channel strip.](image)

**ASSIGNING OUTPUTS TO BUSSES**
As shown earlier in Figure 7-4 on page 36, any outputs that you set to *From Computer* in the MOTU 324 Console will be available in VST. These outputs appear in the Master window as output assignments for the master fader and busses.

![Figure 10-5: Use the output buttons at the bottom of each channel strip, including the master fader, to assign 24i outputs to busses. You can then assign channels in the Monitor window to each bus as desired.](image)
CHANGING 24I SETTINGS
To change the 24i settings at any time, run the MOTU 324 Console. See “The Launch button” on page 48 for details.

SYNCHRONIZATION
Cubase VST can run under its own transport control or slave to SMPTE time code.

Running VST under its own transport control
If you do not need to synchronize VST with time code or another recording device, such as a tape deck, just leave its SMPTE time code synchronization features disabled.

However, even though VST is not slaving to SMPTE time code, you still need to be concerned with the synchronization of the 24i’s digital audio clock with other devices connected to it digitally (if any). For example, if you have a DAT machine connected to the 24i via S/PDIF, you need to make sure that their audio clocks are phase-locked. For details, see “Connect word clock” on page 23. If you don’t have any digital audio devices connected to the 24i, digital audio phase-lock does not apply to you.

Slaving VST and the 24i to SMPTE time code
If you need to slave VST and the 24i system to SMPTE time code, follow the instructions in your VST manual for slaving VST to MIDI Time Code (MTC). To ensure that your audio tracks don’t drift out of sync with your MIDI tracks — or time code, use a hardware synchronizer like the MIDI Timepiece AV or Digital Timepiece to slave the 24i hardware to the SMPTE (or MIDI Time) Code as well. A digital audio synchronizer is required for drift-free SMPTE/MIDI time code sync. Make sure the Clock Source setting in the MOTU 324 Console window has the appropriate setting for locking the 24i system to the synchronizer. For examples of how to set this up, see “Connect word clock” on page 23.

24-BIT OPERATION
Your 24i hardware supports Cubase VST’s 24-bit recording capabilities. Simply enable 24-bit operation in VST as instructed in your VST manual. The 24i system always supplies VST with a 24-bit data stream, and when you enable 24-bit operation in VST, it simply uses all 24-bits supplied by the 24i hardware.

MONITORING SYSTEM PERFORMANCE
Keep the Audio Performance window open (from the Audio menu) to keep tabs on the load on your CPU and disk buffers. If the meters get too high, you can reduce the load by reducing the number VST plug-ins you are working with.

Figure 10-6: Keep the Audio Performance window open to keep tabs on your computer’s processing power and hard disk performance.
CHAPTER 11  Sound Manager

OVERVIEW
The Apple Sound Manager is a standard Mac OS System Extension that provides stereo sound capabilities on your Power Macintosh.

* In Mac OS 8 or higher, Sound Manager has been rolled into the Macintosh’s operating system. It does not exist as a separate System Extension.

The 24i ships with a Sound Manager driver for the PCI-324 audio card. This driver allows your Power Macintosh to use any pair of inputs and outputs (analog or digital) on your 24i system.

USING 3RD PARTY AUDIO SOFTWARE
Just about every dedicated audio application for Macintosh supports Sound Manager, along with many other applications, like video editing software, that handle audio in one form or another. Once you’ve installed and configured the MOTU 324 Sound Manager driver as described in this chapter, you’ll be able to use any pair of 24i inputs and outputs (analog or digital) to record and play back audio from any Sound Manager compatible program.

SOUND MANAGER IS STEREO ONLY
Sound Manager currently only supports stereo input and output. Therefore, Sound Manager compatible programs can only record two channels at a time with your 24i hardware. Similarly, they can play back audio through one stereo output pair on the 24i, although most multi-track audio applications can internally mix more than two tracks to stereo. Consult your software's documentation for details.

INSTALLING THE PCI-324 SOUND MANAGER DRIVER
The MOTU 324 Sound Manager Driver is a standard Macintosh System Extension. When properly installed, it resides in the Extensions Folder of the System Folder on your computer’s startup disk.

To install the PCI-324 Sound Manager driver:

1  Insert the 24i installer CD-ROM into your Macintosh.

2  Run the 24i software installer.
3 Enable (check) the MOTU 324 Sound Manager Driver option, along with any other packages you would like to install at this time.

4 Click Install.

5 Complete the installation as instructed by the installer. Because the MOTU 324 Sound Manager driver is a System Extension, the installer will ask you to restart the computer.

SOUND CONTROL PANEL IS REQUIRED
Recent versions of System 7 and Mac OS 8 ship with a Control Panel called Monitors & Sound. Unfortunately, this Control Panel does not provide a way to select the PCI-324 card as an input source and output destination.

Instead, you need the Sound Control Panel, which allows you choose the 24i as an output for Sound Manager. Fortunately, even the latest versions of the Mac OS installer CD-ROM include the Sound Control Panel in the Apple Extras Folder.

Locating the Sound Control Panel
If the Sound Control Panel is not present in your Control Panels folder, do the following:

1 Switch to the Mac OS Finder (if you are not there already).

2 Press command-F, or choose Find from the File menu.

The Find window appears.

3 Search on the name Sound.

4 In the resulting list of found items, look alphabetically for an item called Sound.

If the Sound Control Panel doesn’t turn up in the Find operation, insert the Mac OS Installer CD-ROM that shipped with your computer and try again, searching on the CD-ROM. It will probably be there.

Once you’ve located the Sound Control Panel, you can place it anywhere you like on your hard drive, as it operates like a standard application. Just double-click it to launch it.

SYSTEM 7 USERS NEED SOUND MANAGER
If you are running System 7, you need the Sound Manager System Extension (Version 3.2.1 or higher). The 24i installer will install it in your System 7 Extensions folder. Make sure that it is enabled in Extensions Manager.

Mac OS 8 does not require this extension, as it has been rolled into Mac OS 8 itself.

INSTALLATION SUMMARY
Here is what you should have by now:

- The MOTU 324 Sound Manager driver is installed as a System Extension.
- The Sound Control panel is somewhere on your hard drive.
- If you are running System 7, the Sound Manager System Extension (Version 3.2.1 or higher) is installed.
As part of the standard 24i software installation, a copy of the MOTU 324 Console application is now on your hard drive.

If all these things are true, you are ready to activate the 24i hardware as your Sound Manager input source and output destination.

**ENABLING 24I INPUTS AND OUTPUTS**

Before you set up Sound Manager, you need to run the MOTU 324 Console and enable the input pair and output pair you would like to use for Sound Manager.

1. Launch the MOTU 324 Console.

2. Choose the desired sample rate.

3. From the **Monitor Outputs** menu, choose the desired output pair for Sound Manager as shown below in Figure 11-3. If the pair you want is not available in the menu, choose **From Computer** from the desired **Output Source** menu below.

4. As shown in Figure 11-3, check the box next to the input pair you would like to use for Sound Manager.

5. Quit the MOTU 324 Console.

**CONFIGURING THE SOUND CONTROL PANEL**

Once you’ve made the preparations discussed in the previous section in the MOTU 324 Console, you are ready to make your final settings in the Sound Control Panel as follows:

1. Open the Sound Control Panel.

2. Choose **Alert Sounds** from the menu.

3. Lower the **Alert Sound** volume. This prevents the Macintosh alert sound from blurring out of your 24i system.

4. Choose **Sound In** from the menu, click the MOTU 324 driver icon, and click the **Options** button to choose the desired 24i input pair.
5 Choose Sound Out from the menu, click the MOTU 324 driver icon, and choose the desired sample rate.

6 Choose Volumes from the menu, and make sure that the MOTU PCI-324 is not muted. If your audio software has its own volume control for Sound Manager output, raise this volume slider to full volume. You can attenuate it as needed in your audio software.

That’s it. You can now run any Sound Manager compatible audio software, and play back audio through the 24i outputs you’ve chosen in the MOTU 324 Console Monitor Outputs menu.

CHANGING THE INPUTS OR OUTPUTS
To change the 24i inputs or outputs being used by Sound Manager, run the MOTU 324 Console.

To change the output, choose the desired output pair from the Monitor Outputs menu as shown in Figure 11-3 on page 55.

To change the input, check the box next to the desired input pair (if it isn’t already checked). Then open the Sound Control panel, choose Sound In, click the Options button, and choose the desired input from the menu as shown in Figure 11-5.

MONITORING LIVE INPUTS
If you would like to listen to live inputs as you are recording them into your Sound Manager application, you need to use the PCI-324’s Cue Mix feature. For details, see “324 Cue Mix Console” on page 64.
DEACTIVATING THE DRIVER
You can deactivate the MOTU 324 Sound Manager driver at any time by choosing the Extensions Manager Control Panel and unchecking it in the list as shown below.

Figure 11-6: The MOTU 324 Sound Manager Driver is a standard system extension that can be enabled and disabled with Extensions Manager.
CHAPTER 12   Expanding Your 24i System

OVERVIEW
Up to three 24i I/Os can be connected to a single PCI-324 card for a total of 72 inputs and 18 output connections.

The PCI-324 card ties all three 24i's together, allowing them to act as a massive, 72 by 18 matrix for mixing, merging, splitting and routing to/from all connected inputs and outputs.

24i I/Os are sold separately as expanders for a core 24i system. See your Mark of the Unicorn dealer for details.

You can also add MOTU 2408, 1224 and 308 expansion interfaces to a core 24i system.

Connecting additional 24i's ............................ 57
Multiple 24i's in the 324 Console window ........ 57
Audio routing ............................................ 58
Patchbay routing among 24i I/Os ............... 58
Synchronizing multiple 24i's ....................... 58
Word clock connections are not necessary ...... 59
Connecting MOTU 2408 I/Os ....................... 59

CONNECTING ADDITIONAL 24i's
Connect additional 24i's to the two available Audio Wire jacks on your core system's PCI-324 card as shown below in Figure 12-1.

![Diagram of connecting additional 24i's to a PCI-324 card]

Important note: when connecting multiple interfaces to a single PCI-324 card, be sure to turn them all on when you're using the system, even if you don't plan to use a particular interface. This ensures trouble-free operation.

MULTIPLE 24i's IN THE 324 CONSOLE WINDOW
The MOTU 324 Console window displays the settings for one 24i I/O at a time. To choose which I/O you are looking at, choose it from the Configure Interface menu as shown below in Figure 12-2.
EXPANDING YOUR 24I SYSTEM

Audio routing
Audio routing in the MOTU 324 Console window works the same for multiple 24i's as it does for a single 24i, except that the inputs for two or three I/Os appear in the Output Source menus, as demonstrated below in Figure 12-3 with additional 1224 and 2408 interfaces.

Patchbay routing among 24i I/Os
To route any input directly to any output, choose the desired input from the appropriate Output Source menu, as usual. In Figure 12-4 below, the AES/EBU inputs on a 1224 interface are being routed to the main outputs on the 24i. For a further explanation about using these menus, see “Output Source” on page 36.

SYNCHRONIZING MULTIPLE 24I'S
The entire 24i system gets its clock from whatever you choose from the Clock Source menu in the MOTU 324 Console window. When you connect multiple 24i I/Os to the PCI-324 card, all of their respective sync sources are displayed in the menu as shown below in Figure 12-5.

In the MOTU 324 Console window menus, each input is identified by the 24i it belongs to (the I/Os are numbered 1, 2 and 3), the audio format for the bank, the bank identifier (labeled A, B or C), and finally by its input pair.

Figure 12-2: Choosing which 24i you are working with in the MOTU 324 Console window. In this example, the expanded system includes three 24i audio interfaces.

Figure 12-3: The menus in 324 Console show the inputs of all connected 24i's (and other connected interfaces). You can use these menus to route any input to any output. In this example, a 24i interface is connected to Audio Wire 1, a 1224 interface is connected to Audio Wire 2, and a 2408 interface is connected to Audio Wire 3.

Figure 12-4: The menus in 324 Console show the inputs and outputs of all connected 24i's. You can use these menus to route any input to any output. In this example, the AES/EBU inputs of a connected 1224 (circled) are being routed to the main outputs of the 24i.

SYNCHRONIZING MULTIPLE 24I'S
The entire 24i system gets its clock from whatever you choose from the Clock Source menu in the MOTU 324 Console window. When you connect multiple 24i I/Os to the PCI-324 card, all of their respective sync sources are displayed in the menu as shown below in Figure 12-5.

In the MOTU 324 Console window menus, each input is identified by the 24i it belongs to (the I/Os are numbered 1, 2 and 3), the audio format for the bank, the bank identifier (labeled A, B or C), and finally by its input pair.

Figure 12-5: The entire 24i system can get its clock from the PCI-324 card itself or any sync source on any connected 24i (or other interface). After you choose a source from this menu, the entire system, including all connected 24i’s, synchronizes to it.
Word clock connections are not necessary
Each 24i in the system gets its clock from the Audio Wire cable connection to the PCI-324 card (unless its the master clock itself). There is no need to make word clock connections between multiple 24i I/Os.

Connecting MOTU 2408 I/Os
You can connect up to two MOTU 2408 I/Os to a core 24i system. Each 2408 I/O adds 24 channels of input and output, 58 input connections and 62 output connections.

Just add them to the two addition Audio Wire connectors on the PCI-324 card as shown earlier in Figure 12-1 on page 57. Then configure them in the 324 Console Window as usual by choosing them from the Configure Interface menu as shown in Figure 12-2 on page 58. Your PCI-324 card seamlessly integrates them with the 24i, creating a completely flexible patch bay, where you can mix, merge split, and otherwise route data between any of the three I/Os.
CHAPTER 13  Reducing Latency

OVERVIEW

Latency is the amount of time it takes for audio to be patched through your 24i system, from when it first enters a 24i input, passes through the 24i hardware into the computer, through your host audio software, and then back out a 24i output.

The delay is small but audible (from just a few milliseconds to several dozen milliseconds, depending on the 24i driver settings). Latency is most noticeable when you patch live audio through the 24i system and your audio software. For example, you might have MIDI instruments, samplers, microphones, a guitar, a digital mixer or other live audio sources connected directly to 24i analog inputs. And if so, you will probably want to monitor those live inputs through your audio software, possibly even with some real-time effects processing (such as reverb) applied to the live input. You may also want to listen to the live input along with existing tracks that you’ve already recorded on your hard drive. However, when doing so, you’ll hear a delay between the live inputs and the tracks already recorded. The live input will sound just a little bit late.

Your 24i software offers several different ways to reduce latency — and even make it completely inaudible. You can take these measures regardless of what host audio application software you use.

‘SAMPLES PER BUFFER’

As shown below in Figure 13-1 below, the ‘Samples per Buffer’ setting determines the size of the buffers used by the MOTU Audio System to transfer audio to and from the 24i hardware. This setting can be used to reduce latency.

Figure 13-1: Lowering the ‘Samples Per Buffer’ setting in the MOTU 324 Console Window reduces patch thru latency. But doing so increases the processing load on your computer, so keep an eye on the Performance Monitor window in AudioDesk (or similar feature in your host audio software). If you hear distortion in your audio at lower Samples Per Buffer settings, open Cue Mix Console; its message center can help you find the best buffer size for your system.

For details on how to access the MOTU 324 Console window show above in Figure 13-1, see “Accessing the 324 console window” on page 31.

The ‘Samples Per Buffer’ setting has a large impact on the following things:

- Patch thru latency
- The load on your computer’s CPU
- Possible distortion at the smallest settings
- How responsive the transport controls are in AudioDesk, Digital Performer or other audio software
Lower latency versus higher CPU overhead
This setting presents you with a trade-off between the processing power of your computer and the delay of live audio as it is being patched through your system. If you reduce the buffer size, you reduce patch thru latency, but significantly increase the overall processing load on your computer, leaving less CPU bandwidth for things like real-time effects processing. On the other hand, if you increase the buffer size, you reduce the load on your computer, freeing up bandwidth for effects, mixing and other real-time operations.

If you are at a point in your recording project where you are not currently working with live, patched-thru material (e.g. you’re not recording vocals), or if you have a way of externally monitoring input, choose a higher buffer size. Depending on your computer’s CPU speed, you might find that settings in the middle work best (256 to 2048).

Transport responsiveness
The 'Samples Per Buffer' setting also impacts how quickly your audio software will respond when you begin playback, although not by amounts that are very noticeable. Lowering the buffer size will make your software respond faster; raising the buffer size will make it a little bit slower, but barely enough to notice.

Effects processing and automated mixing
Reducing latency with the 'Samples Per Buffer' setting has another benefit: it lets you route live inputs through the real-time effects processing and mix automation of your audio software.

EVEN LOWER LATENCY WITH CUE MIX
The 24i software driver has a more direct method of patching audio through your 24i system. This method is called Cue Mix. When enabled, Cue Mix activates a very low-level patch-thru in the 324 driver. Cue Mix has two important benefits: first, it drastically reduces the patch thru delay (latency) — to less than a quarter of the latency when it is not enabled. Secondly, it does so with very little extra strain on the computer. The trade-off, however, is that this setting does not allow you to patch the live audio through your host audio software. Instead, live audio inputs are patched directly through to outputs by the 324 driver and are mixed with tracks playing back from your audio software by the driver. This means that you cannot apply any of the real-time effects processing, mix automation, or other real-time effects that your audio software provides. But if you are simply tracking and don’t need these types of features as you record, definitely use this feature. On the other hand, if you really need to use the mixing and processing provided by your audio software, you should not use Cue Mix and try to reduce latency with the 'Samples Per Buffer' setting instead (explained earlier).

Turning on Cue Mix
There are several ways to turn on Cue Mix, depending on what type of host application you are using with the 24i system.

AudioDesk and Digital Performer
To turn on Cue Mix in AudioDesk and Digital Performer:

1. From the Basics menu, choose MOTU Audio System options>Input Monitoring Mode.
2. Choose the Direct hardware playthrough option.
3. From the Basics menu, choose MOTU Audio System options>Configure Hardware Driver.
4. Enable the Auto Cue Mix Update check box. This setting gives you level and pan control of the Cue Mix from the Mixing Board window in AudioDesk or Digital Performer. For details, see “Cue Mix with Digital Performer / AudioDesk” on page 63.
5. From the Windows menu, choose Audio Monitor, and enable Patch Thru (the button with the headphone icon on it).
REDUCING LATENCY

Figure 13-2: Turning on Cue Mix from AudioDesk or Digital Performer.

Sound Manager applications
To enable Cue Mix for a host application that is using the MOTU 324 Sound Manager driver:

1. Make all of the Sound Manager preparations described in chapter 11, “Sound Manager” (page 51).

2. Open the Monitors & Sound Control Panel, click the Sound button, and check the Listen check box. Alternately, you can open the 324 Cue Mix console (described later in this chapter) and turn on Cue Mix from there, which does the same thing.

3. To control the overall level of the Cue Mix input, Use the 324 Cue Mix Console as described later in this chapter.

Some Sound Manager compatible applications may also allow you to turn on Cue Mix patch thru from within the program.

Cubase VST (or other ASIO-compatible apps)
Remember, you can reduce the patch thru latency in Cubase VST by lowering the ‘Samples Per Buffer’ setting as described earlier in this chapter. Doing so allows you to lower the latency and still apply VST plug-ins to the live input. However, you can reduce the latency further — but with no real-time VST effects — by enabling Cue Mix. To enable Cue Mix for VST:

1. From the Audio menu, choose System.

2. In the Monitoring section, choose Global Disable. This is because the 324 driver is going to provide monitoring instead of VST.

3. Run the 324 Cue Mix Console (described later in this chapter) to turn on Cue Mix and control the output assignments, volume and panning of the inputs being monitored through Cue Mix.

CUE MIX WITH DIGITAL PERFORMER / AUDIODESK
If you are running AudioDesk or Digital Performer, you have two choices for how to control the volume and pan of each individual Cue Mix input:

- From the Mixing Board window in AudioDesk or Digital Performer
OR

- From the separate 324 Cue Mix Console

If you would like to control the Cue Mix volume and panning from the Mixing Board, just make sure that the Auto Cue Mix Update option is checked in the 324 Console Window as shown in Figure 13-2 on page 63. This makes the Cue Mix follow the volume fader and pan knob settings for each record-enabled track in the Mixing Board window.

If you would like to make separate Cue Mix settings for some reason, uncheck the Auto Cue Mix Update option and run the 324 Cue Mix Console application as described in the next section.

324 CUE MIX CONSOLE

If you are using Cue Mix with any application other than AudioDesk or Digital Performer, or you are using AudioDesk or Digital Performer without the Auto Cue Mix Update option, the 324 Cue Mix Console lets you control the output assignment, volume level, and pan setting for each Cue Mix input.

The 324 Cue Mix Console is installed with the rest of your 24i software on the top level of your startup hard drive.

The Cue Mix Console provides the following controls.

Master On/Off button

The master On/Off button turns Cue Mix on or off. But remember, it is a global setting. If you turn it on in the Cue Mix Console, it can get turned off by AudioDesk or Digital Performer, depending on their settings. See “Turning on Cue Mix” on page 62.
Cue Mix Output Assignments
These four menus let you choose up to four output pairs as Cue Mix outputs. The outputs that appear in these menus are the Output Source menus in the 324 Console window that have been given the From Computer designation.

Master Cue Mix volume
This fader, on the right-hand side of the mixer, controls the overall Cue Mix level. Use the individual input faders to the left to control individual Cue Mix input levels.

Input channel strips
Each input that is enabled (checked) in the 324 Console window appears as a channel strip in the 324 Cue Mix Console. Each input has the following controls:

Output enable buttons
Click the output(s), 1 through 4, that you would like to monitor the input on. These buttons let you send the input to as many as four different output pairs on the 24i, if you want. Most of the time, you’ll probably want to simply monitor all inputs on a single output pair, so you’ll use only one of these buttons at a time.

Individual input enable/disable button
This button lets you enable or disable the individual input.

Pan knob
This pans the Cue Mix input across its corresponding output pair.

Volume fader
Each input has a Cue Mix fader to control its volume.

All of the control listed above are overridden by AudioDesk and Digital Performer if the Auto Cue Mix Update option is checked in the 324 Console window.

Message Center
The message center displays useful information, such as recommendations for the buffer size. It also reports errors that it detects in the operation of your system, and makes recommendations on how to address the problem. The messages displayed here do not only have to do with Cue Mix; they can also apply to the overall operation of the PCI-324 card and the 24i system. Use it as a handy monitor of your system’s performance.
CHAPTER 14 Troubleshooting

TROUBLESHOOTING
Sometimes, the ADAT sync cable seems to be plugged into the card, and partially works - but it isn’t really all the way in because it binds against the side of the bulkhead slot. This can cause clicks when slaved to 324 ADAT. Make sure it is really seated firmly. Connect the ADAT sync before screwing the card down - this will ensure that it is aligned properly.

ADATs can take a while to sync to the Digital Timepiece. For instance, when recording out to the ADATs, they can appear to chase and lock, but the record button is still flashing. Recorded data on the tape won’t be sample accurate until the record light stops flashing. Be sure to give ADATs enough time to lock.

If you experience poor recording and playback performance in Cubase VST, try turning off the Recorded Buffers go direct to disk option in the System dialog (Audio menu).

If you hear click and pops in your audio, try increasing the Buffer Size in the MOTU 324 Console window.

CUSTOMER SUPPORT
We are happy to provide customer support to our registered users. If you haven’t already done so, please take a moment to complete the registration card included with your 24i system. When we receive your card, you’ll be placed on our mailing list for free software updates and information about new products.

REPLACING DISKS
If your 24i software CD-ROM becomes damaged and fails to provide you with fresh, working copies of the program, or if your AudioDesk master disks need replacing, our Customer Support Department will be glad to replace it. You can request a replacement disc by calling our business office at (617) 576-2760 and asking for the customer service department.

TECHNICAL SUPPORT
If you are unable, with your dealer’s help, to solve problems you encounter with the 24i system, you may contact our technical support department in one of the following ways:

- Tech support 24-hour fax line: (617) 354-3068
- Tech support email: techsupport@motu.com
- Web site: www.motu.com

Please provide the following information to help us solve your problem as quickly as possible:

- The serial number of the 24i system. This is printed on a sticker placed on the bottom of the 24i rack unit. You must be able to supply this number to receive technical support.
- Software version numbers for:
  - AudioDesk
  - The version numbers of the items in the MOTU Folder (in the Extensions Folder of your startup disk), including the PCI-324 Driver, the MOTU Audio System, and MOTU Public Objects
■ A brief explanation of the problem, including the exact sequence of actions which cause it, and the contents of any error messages which appear on the screen.

■ The pages in the manual which refer to the parts of the 24i or AudioDesk with which you are having trouble.

■ The version or creation date of the system software you are using to run the Macintosh. This can be found by choosing About this Computer from the Apple menu.

We're not able to solve every problem immediately, but a quick call to us may yield a suggestion for a problem which you might otherwise spend hours trying to track down.

Our technical support department is dedicated to helping registered users solve their problems quickly. In the past, many people have also taken the time to write to us with their comments, criticism and suggestions for improved versions of our products. We thank them; many of those ideas have been addressed in our development efforts. If you have features or ideas you would like to see implemented, we'd like to hear from you. Please write to the 24i Development Team, Mark of the Unicorn Inc., 1280 Massachusetts Avenue, Cambridge, MA 02138.
<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>ADAT Sync 7&lt;br&gt;ADAT sync&lt;br&gt;sync setting 33&lt;br&gt;ASIO 27, 29, 47&lt;br&gt;Audio bit resolution 33&lt;br&gt;Audio Wire 6, 7, 21&lt;br&gt;AudioDesk 27, 29, 43</td>
</tr>
<tr>
<td>B</td>
<td>Bank C&lt;br&gt;format setting 35&lt;br&gt;Buffer Size 34</td>
</tr>
<tr>
<td>C</td>
<td>Clock source 33&lt;br&gt;Configure Hardware Driver 11, 31&lt;br&gt;Configure interface setting 35&lt;br&gt;Control Track 7&lt;br&gt;Control Track (sync setting) 33&lt;br&gt;Cue Mix 62&lt;br&gt;Cue Mix Console 64&lt;br&gt;Customer support 67</td>
</tr>
<tr>
<td>D</td>
<td>DAT&lt;br&gt;sync settings for 24i 33&lt;br&gt;Digital Performer 39&lt;br&gt;Digital Timepiece</td>
</tr>
<tr>
<td>E</td>
<td>Enable Inputs setting 36&lt;br&gt;Expansion 57&lt;br&gt;adding a 2408 57</td>
</tr>
<tr>
<td>F</td>
<td>Format conversion 58&lt;br&gt;From Computer setting 36&lt;br&gt;Front panel 5</td>
</tr>
<tr>
<td>G</td>
<td>Hardware installation 19</td>
</tr>
<tr>
<td>H</td>
<td>Hardware installation 19&lt;br&gt;Hardware installation 19&lt;br&gt;Installation hardware 19&lt;br&gt;software 27&lt;br&gt;Interface options 37&lt;br&gt;Internal (sync setting) 33, 34</td>
</tr>
<tr>
<td>I</td>
<td>Latency 22, 34, 61&lt;br&gt;Load Config button 37</td>
</tr>
<tr>
<td>J</td>
<td>MacOS&lt;br&gt;Sound Manager 51&lt;br&gt;Monitor Outputs 35&lt;br&gt;Mono Routing 37&lt;br&gt;MOTU 324 Console 11, 27, 28, 31&lt;br&gt;MOTU 324 Sound Mgr Driver 51&lt;br&gt;MOTU Audio System bit resolution 33&lt;br&gt;MOTU Folder 27, 28&lt;br&gt;MOTU Setup Wizard 19, 27</td>
</tr>
<tr>
<td>K</td>
<td>Optimization 62&lt;br&gt;Output Source setting 36</td>
</tr>
<tr>
<td>L</td>
<td>PCI-324 ADAT setting 33&lt;br&gt;PCI-324 Console 31&lt;br&gt;PCI-324 Control Track setting 33&lt;br&gt;PCI-324 Cue Mix 62&lt;br&gt;PCI-324 Cue Mix Console 64&lt;br&gt;Performance 62</td>
</tr>
<tr>
<td>M</td>
<td>Rear panel 6&lt;br&gt;Refresh button 37</td>
</tr>
<tr>
<td>N</td>
<td>Sample rate 33&lt;br&gt;Sound Manager 33&lt;br&gt;Samples per buffer 34&lt;br&gt;Save Config button 37&lt;br&gt;Setup Wizard 19, 27&lt;br&gt;Software installation 27&lt;br&gt;Sound Control Panel 52&lt;br&gt;Sound control panel rate (bit resolution) 33&lt;br&gt;Sound Manager 51 bit resolution 33&lt;br&gt;sample rate 33&lt;br&gt;Sound Manager Driver 30&lt;br&gt;Steinberg VST 47&lt;br&gt;Synchronization 23&lt;br&gt;System 7 32</td>
</tr>
<tr>
<td>O</td>
<td>Technical support 67&lt;br&gt;Total PCI use 67</td>
</tr>
<tr>
<td>P</td>
<td>VST 47&lt;br&gt;Wizard 19&lt;br&gt;Word clock 6 sync setting 34</td>
</tr>
</tbody>
</table>
| Q | VST 47